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Introduction 5

1 Introduction

1.1 About HIPAA Premium Payment Master

HIPAA Premium Payment Master is a tool to receive and display, print or translate
electronic premium payment records that come in the form of X12 820 transactions.

Some health plan sponsors, private industries as well as government sponsors will transmit
the information on premium payments for members to administering health plans
through the 820-transaction set. Though still rare, under HIPAA a payer has to be ready
to accept X12 820 EDI transactions.

With the HIPAA Premium Payment Master, you can conduct premium payment-related e-
business. Some employers, group sponsors or state agencies will use this new format to
announce premium payments.

The following picture shows the startup screen of the HIPAAsuite Premium Payment
Master.

@ HIPAA Premium Payment Master - G4bit
File  Wieww CodaZSets DataBase Imasge Setup Log EDIExchange  Help

| - . [ =W
- AN = A9DQ
Output Mode
" Printer
* Scresn
" Image
™ Data Import
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Run p' L ’ P
=
Exit
File Name : No update avaiable .:

The startup screen of the HIPAA Premium Payment Master
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The HIPAA Premium Payment Master

2.1

Getting Started

Starting the Application

Once the HIPAA Premium Payment Master is installed, you can launch it from the "Start”
menu:

Start » Programs (All Programs) » HIPAASuite » HIPAA Premium Payment Master.

- S DL
HIF&R, Authorizer Nebwork
HIFAS Claim Masker
HIFAS Claim Payment Masber Control Panel
HIFAR, Claim Status Responder
HIFAR Comm Cenker Devices and Printers
HIFAA Elighility Responder
HIFPAA Enrolment: Masker Administrative Toolks
HIFAA Premium Payment Master
HIPAAsvite =| Run..

- Windows Secusity

L4

I |Search programs and Files

!:}J Log off rl

LY Q>

The HIPAA Premium Payment Master launched from the "Start” menu

=

The following screen will appear:
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B HIPAA Premium Payment Master - G4bit
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& > = AT
~ Dutput Mode -
" Printer
* Scieen
" Image
™ Data Import
- Counter .
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Fibs Name :

EDI Exchange  Help

Mo update avalable .:

The HIPAA Premium Payment Master main window

Once the main program window is opened, the normal operation now would be to open

an EDI file. See:

e Processing an EDI File

e Processing an Entire Directory

2.2 Familiarizing with the Interface

The Top Menu
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2.3

The top menu lets you access all features of the program.

The Task Bar

The task bar gives you access to the most used tasks:
* Opening a file
e Starting the processing
* Moving to the next record
¢ Viewing the EDI file
e Accessing the application settings
¢ Help documentation
e Toggling the file processing panel on or off

e The manual in PDF format

Bottom Pane

In the bottom left, you can see the file name when the file is opened. In the bottom left
corner you can see if a program update is available.

When started, The HIPAA Premium Payment Master accesses HIPAAsuite's website and
checks for a newer version. If one is available, then you are notified. You can turn this
feature off. Refer to Updating the Program.

Processing an EDI File

Depending on the output mode, the individual records may be:
¢ Displayed on the screen, one by one,
e Printed as batch to the selected printer or

e Written to the database without displaying the form.

Follow the instructions below to open a single 820 EDI file and display its details on screen
in easy-to-read table format.
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Getting Started 9

1. Go to File » Open in the main menu.

':ilHlP‘.ﬂ.ﬂ. Premium Payment Master - Babit

| File | Wiew CodeSets DataBase Image Setup

f Open Sample Files :

= open

[ Open Directory
Imnport CHEX, File

Seleck Printer

Exit

The "Open” menu

Alternatively, click on the "Open Document” icon shortcut located on the program
toolbar.

& HIPAA Premium Payment Master - G-4bit

File Wiew CodeSsts DataBase Image Setup Log EDIExchange  Help

LA AL A9 O

The "Open Document” button

2. Browse through the folders and select a file with . edi extension. Click "Open."

Note: Only payment files in "ANSI 820" format can be opened via the HIPAA Premium Payment Master.
The program will display an error message if you select a file in a different format.
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10 The HIPAA Premium Payment Master

kP )| - ProgramData ~ HIPAAsite ~ HIPAA Premim Payment Master + Samples v K53 [ seach samples ()
Organize =  New folder = w [ @
¢ Eavarites =1 Mame = Date modified IT','pe Size I |
B Deskiop 820_1.edi 11/4/2013 1231 P EDIFile 1KB
& Downloads | 620_2.edi 11/4/201312:31 PM  EDIFile 1EB
- Recent Places BEEr 11/4{201312/31 P EDIFile 168
= Lbvariss 820_4.edi 11/4/201312:31 B EDIFile 1KB
#| Documents
o' Music
= Pichures
E Videos
B Computer
£ Local DiskiC2)
. DATAPARTL (D) —
¥ D on CVK
=l
File name: Il j |£IJI Files (*.*3 j
' Open | Cancel |
o

The "Open"” window

3. Make sure the program tool bar is displayed in the left area. To display the left
program bar with options, select View » Info Bar.

4. Select one of the following modes in the "Output Mode" box. The Output mode defines
the destination where the result file will be sent to. In our example, we select the
"Screen” mode.

¢ Printer — This option allows to print the opened EDI file. Bypassing the screen, all
the records are sent to the printer for output. See also: Printing Payment Records.

e Screen — This is a default mode. Select this option to display the Information of
the membership records in the preview window in a special form.

¢ Image — This mode mode creates TIFF or PDF file from the EDI file. Read more in
Creating Image Files from EDI.

 Dutput Mode
| Printer
*  Seresn

" | Image

The "Output Mode" options

5. The file is now open. Click the "Run" button to process the file.
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‘ HIFAA Premium Payment

File View CodeSets D=

@!%/?

Output Mode
" Prinker

* Screen

" Image
[ Data Import
Counter

lpmem Count |

Run .‘

The "Run” buttons

6. When you click on the "Run” button, the file will be parsed and the information
displayed. As in our example the output mode is "Screen,"” the payment is displayed in a
separate window. See Displaying 820 EDI Files.

If you choose an output mode other than Screen, you will see the hourglass mouse pointer
until the parsing has been completed.

2.4 Processing an Entire Directory
The "Open Directory” function works only when the output mode is not "Screen” but "Data
Export” or "Image File".
Follow the instructions below to open a batch of EDI files located in one folder.

1. Make sure the "Printer” or "Image File" mode is selected in the "Output Mode" box. The

© <2006> ... Martin Scholl Consulting, Inc.
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The HIPAA Premium Payment Master

Output mode defines the destination where the result file will be sent to.

Note: You cannot display a batch of EDI files on screen in a preview window, it is possible only for one

file. See Opening 820 EDI Files.

— Dutput Mode
& P

™ Screen
" Image

The "Output Mode" options

Note: If you select the "Image File" format for the first time, you need to define the image options.

See Doing Image Setup.

2. Go to File » Open Directory in the main menu.

8 HIPAA Premibum Payment Master - b4bit

| File | Wiews CodeSets  DataBase  Image

Opini Samiphe Files
o Open
| Irnport CHEX, filis

Seleck Printer

Exit

The "Open Directory” menu

3. Browse for the folder containing EDI files. Click on that folder and then click "OK."

Note: Only claim files in "ANSI 820" format can be opened via the Claim Premium Payment Master. The
program will display an error message if you select a file in a different format.

Browse For Folder E

E HIPAS Clarm Stabus Responder
[ HIFAS Eligibilty Responder
[+ HIFAA Enrcliment Masher

. Configuration
. Logs
Bsrpie:

. Scripks

ul|

=] HIFAS Premium Payment Masher

makenewrolder | ([ ok |

RN
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The "Browse for Folder" popup

4. Click on the "Run" button to send all files from the folder to the destination.

13

Note: The pre-defined settings will be applied. To print the files to image, configure the settings. See

also: Configuring Program Options, Doing Image Setup.

'ﬁHIFAn Premium Payment
File  Wiew CodeSets De

= (> =

— Dutput Mode
% Prinder

{'\F I

" Image

™ Data Import

Counltes

Fayment Count

FProcessed Files

Exit |

File: Name :

The "Run" buttons

5. The "Counter” pane displays information online on the processed documents.
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The HIPAA Premium Payment Master

~ Counter

Fayment Count
| 1|

Frocessed Files
1 of 4|

oo @ |

r

Exit |

[P Mafie:

The "Counter” pane

6. The displayed "Processing Results" popup will report about operation results.
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Getting Started 15

Processing Results

FProcessing of the file 820_1.edi began at 11/11/2013 2:28:39 AM
Fremium Faymeants will be printed
1 Records have been processed
1 Premium Fayment Records have been printed
Processing of the file 820_1.edi ended at 11/11/2013 2:28:54 AM

Frocessing of the file 320_2 edi began at 11/11/2013 2:28:56 Ak
Premiurn Payments will be printed
4 Records have been processed
4 Premiurm Payment Records hawve been printed
Frocessing of the file 820_2 edi ended at 11/11,/2013 2:29:13 AM

Frocessing of the file 320_3.edi began at 11/11/2013 2:29:15 AM
Fremium Payments will be printed
1 Becords have been processed
1 Premium Payment Records have been printed
Frocessing of the file 820_3.edi ended at 11/11/2013 2:29:30 AM

Frocessing of the file 320_4. edi began at 11/11/2013 2:29:32 AM
Premiurn Fayments will be printed
3 Records have been processed
3 Premiur Payment Records have been printed
Frocessing of the file 820_4.edi ended at 11/11/2013 2:29:48 AM

The "Processing Results” window

2.5 Displaying 820 EDI Files

After opening a file and leaving the default output mode "Screen”, click on the "Run”
button. With the output mode set to "Screen,” the payment records are displayed on the
screen. On pressing the "Process” button, the program reads through the EDI file and
parses the individual records into a memory array. Once the parsing is finished the
content is ready to be presented in a window.

© <2006> ... Martin Scholl Consulting, Inc.
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Premium Payment

From ABC PLASTICS To DEF HEALTHCARE CO

1 99821635 1 00n05TE11

Bank Mo ABRA Routing #: 93425TB13 Eank Mo ABA Rouling #: 025677833
Account No; 1234587 Account Ny SABBTTES

Contag Tabephone

Fax: Email

Handling Codé Split Payment and Remittance

Effective Date D620 99T Check or EFT Humber. 12345 Amount  §2,000 00000
CreditDebit Credil Rethod  Automated Clearing House Format  Cash (CCD+)

Plan Humbser GT300

Gonsolidated Invoice 0004369123

1 | individual Remittance SSH 190206123
SMITH , JOHN El 123456
1 | Conlract Humber 190206123 Pary Bem $7,000.00

Coverage Penod

2 | individual Remittance S8 163010163
JOMES , MARY El: TAM016
1 | Conbract Mumber 163910163 Fay lem $10,000.00
Billed Amount £11,000.00
Coverage Penod
Adjustment Reason: Credit for Previpus Overpayment I Amgunt (5100.00}
3 | indevidual Remittance SEN; 1T9203456
JOHNSON , JOE El 934213
1 [_Contract Number. 119203456 | Pay #em $30.00
Coverape Period
Agjustmant Reason: Cradit for Pravious Overpayment | Arniount (§100.00)

Premium payment records of the "Individual Remittance" type
You can see the listing of the insured persons together with policy details.

Below you can see how a summary remittance is displayed. The data structure of those
two versions of the 820 are significantly different.

© <2006> ... Martin Scholl Consulting, Inc.
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HIPAA Preview x|

¢ Print | Close —

Premium Payment

From ABC PLASTICS To DEF HEALTH CARE INC.
Feoeral Taxpayers D 012222222 Duns and Bradsteed 1D 123456789
Bank Mo ABA Routing #: 999999992 Bank Mo ABA Routing ¥: 199999999
Account Mo 12345678 Accournt Mo 98765
Contact Telephone
Fax Email
Handling Code: Payment Accompanies Remittance Advice
Effectve Date 0561997 Chack or EFT Number. 12345 Armount  §1,900,000.00
CreditDebit Credit Method:  Automated Clearing House .i-'arrnat Corp Trade Exch.(CTX)
Plan Number 12345
[ 1 | orpanizati Summary Remittance Duns and Bradsbaed 1D 123456789
1| Iwvolce Number 970501001 | Fay item $16,500.00
Conirol Mumber: 1 Member Count 150 Pearson
Confrol Mumber. 2 Member Count 160 Person
Control MNumber 3 Membaer Count 120 Farson
Control Mumber:. 1 Member Count an Parson
Coningl Mumber 2 Kembsi Counl 135 Paion
2 | voice Mumiber AT0501002 | Fay lem 42 500.00

A premium payment record of the "Summary Remittance" kind

Navigating through the Pages

The screen display of payment records is most often several pages long. Since the HIPAA
Premium Payment Master keeps the payment records in memory, you can easily navigate
through the records back and forth.

The navigation button on top of the display screen for premium payment records.

New TRN segments, which means new transactions trigger the renewed display of the
header record.

Technical Information on Viewing Payment Records

We basically have two quite different remittances that can be formatted into the 820
transaction set.

© <2006> ... Martin Scholl Consulting, Inc.
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The HIPAA Premium Payment Master

8 2 ﬂ Payment Orcer/Remittance Advice

Table 1 - Header

! SEG.ID MAME USHGE REPEAT LioOF REFEAT
"BT 820 Haader

EPR  Financial Information

TRN  Reassociation Key

CUR  Mon-US Dollars Currency

REF  Premiun Recsivers |dentification Key

DTM  Process Dats

DTM  DCelivery Date

DTM  Cowerage Period
LOCP ID - 1000A PREMIUM RECEIVER'S MAME 1

N1 Premium Recsiver's Name

NZ Premium Recsivar Additional Name

N3 Premium Recsiver's Addess

N4 Premium Receiver's City, Stats, Zip
LOOP 1D - 1000B PREMIUM PAYER'S NAME 1

M1 Premiun Payer's Mams

N2 Premiun Payer Additianal Mams

N3 Premiun Payer's Address

N4 Premiumn Payer's City, State, Zip

PER  Premium Payer's Administrative Contact

[

w oo M
A

[ T
e —

Above is the listing for the header part of the 820 record which is shared by both formats. We can have
only one payment (BPR) within an ST-SE loop.

There is the "Summary Remittance":

Table 2 - Detail, Drganizati-::-n Summary Remittance

P SEG.ID MAME LBAGE REPEAT L0 REFEAT
LOOP ID - 20004 ORGANEZATION SUMMARY 1
REMITTANCE

ENT  Onganization Summary Remittancs 5 1
LOGP ID - 23004 ORGANIZATION SUMMARY =1
REMITTANCE DETAIL
REMR  Organization Summary Remnittance Detal R 1
LOGP 1D - 23104 SUMMARY LINEITEM 1
Im Summary Line [tem 5 1
LOGP 1D - 23154 MEMBER COUMNT =1
SLN  Mermber Count 5 1

LOOP ID - 2320A ORGANIZATION SUMMARY =1
REMITTANCE LEVEL ADJUSTMENT

ADX  Organization Summary Remittance Level Adjustment 5 1

The "Summary Remittance”

The summary remittance is typically used when no detail on the covered individuals is
needed. The transaction can tell how many people are insured (Member count), but we
have no information on the names and numbers of those people.

Secondly, we have the "Individual Remittance” which lists every person for whose policy
the remittance is.

© <2006> ... Martin Scholl Consulting, Inc.
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Table 2 - Detail, Individual Remittance

SEG. ID NAME LUSAGE

REPEAT

LiZa0F REFEAT

LOCE 1D - 20008 INDIVIDUAL REMITTANCE
ENT  Individusl Remitlencs

=1

LOCP 1D - 21008 INDIVIDUAL NAME
HM1  Individusl Nams

=1

LOOP ID - 23008 INDIVIDUAL PREMIUM
REMITTANCE DETAIL

RMR  Individusl Premium Remittancs Detail
DTM  Individusl Coverage Pericd

=|

LOOP ID - 23208 INDIVIDWAL PREMIUM
ADJUSTMENT

ADX  Individusl Premium Adjustment

5

1

=1

19

This version has a loop describing the individual policy holder and listing separately the benefits that this

person subscribes to.

We decided to break the EDI record at the "ENT" level into individual records. Records
share the EDI header with the payment, payer and payee information. This information

is present in every record.

Under this Remittance header record are multiple policies with line detail information.

2.6 Printing Payment Records

If you want to print to a printer other than the computer's defined default printer, select the

desired printer. See Selecting a Printer.

Note: The HIPAA products of the latest versions do not need anymore third party software for the
creation of image files. Older versions needed the Peernet Tiff Image Printer or PDF Image Printer

driver installed.

Follow the instructions below to print the payment records.

1. Open an EDI file or directory containing the EDI files in the HIPAA Premium Payment
Master. Read more in Processing an EDI File, Processing an Entire Directory.

Z‘HIPHR Premium Payment Master - G4bit

| File | Wieww (CodeSets DataBase Image  Sebtup

Open Sample Fikes |
|
|&_open |
Open Directory
Imnport CHEX, File

Seleck Prinker
Exit

The "Open Document” button
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20 The HIPAA Premium Payment Master

':,'Hlp.ﬂ..ﬂ. Premium Payment Masber - Bahit

| File [Wiew CodeSets DataBase Image
Cipisn Samphe Files :
& Open

[ opmntrety ]|

Irnport CHEX filie

Seleck Prirter

Exit

The "Open Directory” menu

2. Select the "Printer” option in the "Output Mode" block.

:,' HIFAA Premium Payment

File View CodeSats De

|
i >y
— Output Mode
% Printer
. Screen
" Image

The "Printer” mode

3. Click on the "Run” button.
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't,-H IPAA Premium Payment

— Dutput Mode
% Printer

 Screen

T Image

™ Data Import

-~ Counler

Fayment Count

Processed Files

l |

- |

r— Hur with

compliance chech

Exit |

[P Marne

The "Run" buttons

21

4. The file(s) will be sent to the printer; the "Processing Results” window displays the

report.
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22 The HIPAA Premium Payment Master

Processing Results

FProcessing of the file 820_1.edi began at 11/11/2013 2:28:39 AM
Fremium Faymeants will be printed
1 Records have been processed
1 Premium Fayment Records have been printed
Processing of the file 820_1.edi ended at 11/11/2013 2:28:54 AM

Frocessing of the file 320_2 edi began at 11/11/2013 2:28:56 Ak
Premiurn Payments will be printed
4 Records have been processed
4 Premiurm Payment Records hawve been printed
Frocessing of the file 820_2 edi ended at 11/11,/2013 2:29:13 AM

Frocessing of the file 320_3.edi began at 11/11/2013 2:29:15 AM
Fremium Payments will be printed
1 Becords have been processed
1 Premium Payment Records have been printed
Frocessing of the file 820_3.edi ended at 11/11/2013 2:29:30 AM

Frocessing of the file 320_4. edi began at 11/11/2013 2:29:32 AM
Premiurn Fayments will be printed
3 Records have been processed
3 Premiur Payment Records have been printed
Frocessing of the file 820_4.edi ended at 11/11/2013 2:29:48 AM

The "Processing Results” window

The exact same image that you see on the screen display can be sent to a printer (see
‘Selecting a Printer’) and printed.

Individual records can also be printed out of the display form. In the upper left corner is a
Print’ button
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HIPAL Preview .
Print Close
Prem
From: Health Financing
EQ HTO01502-001
Contact: Jane Doe
Ly

Printing an individual page

2.7 Requesting a Trial Extension

The HIPAA Premium Payment Master comes with a free trial of 14 days. Once your trial
period has expired, the application stops working. There are limitations to the trial
version, for example, you can only export the first 50 records of EDI files, and only 5 files
per directory processing. We are sorry to have to limit the experience, but we had
instances where organizations used the software for production purposes without
purchasing it.

We do not mind extending your trial if you need extra time to evaluate the software.
You will only need to send us the registration number and we will gladly give you another
15 day trial. If your trial time has expired and you wish to continue your testing of the
software, please send an email to info@HIPAAsuite.com with the Registration number
and we will give you a trial extension.

If you need to continue your trial of the product, follow the instructions below.
1. Launch the application.

2. Click on the "Ask for Trial Extension” button on the displayed window.
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Q cense x|

HIPAA Premium Payment Master

225
Day(s) remaining for trial 0

l

This software is for evaluation purposes only and has limited

functionality
You will have to purchase this software if you want to continue using it
after a free evaluation has expired.
48407023 _ l Order Register

The "Ask for Trial Extension" button

Tip: You can see the registration number in the lower left hand corner. This number is needed for the
registration as well as trial extension. It is unique to your computer and hardware. You can hover over
the registration number and copy it to the clipboard, so that you can easily paste it into the email. This
avoids human error. (The letter "0" is never used, only zeros.) Hovering over the number will give you the
following floating menu:

Registration Mumber;

B4E .—-..mc for bia ~
F% opy

Ask for trial extension

3. Clicking on the "Ask for Trial Extension” button will bring up the feature control

window.
Features and Licenses X
HIPAA Premium Payment Master
Evaluation version Enter License Key ]
Product Features: Request Trial License
Image Creation g s:Dn " Off Licensed v
Work with Database * On  Of Licensed [#
EDI Exchange:
Evaluation version Enter EDI Exchange Key |
€ on € Of Request EDI Exchange License |
Save | Registration Mumber: 48407023 Close |
red

The "Features and Licenses” window
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4. Select features you need and click on "Request Trial license.”

5. An email to HIPAAsuite will be created. The message will contain the registration
number so they can then create the extension key. For example, this will open Outlook
with the following data inserted:

e To: info@HIPAAsuite.com

e Subject: [HIPAA Premium Payment Master][123456789]: Request for Trial License
Extension

e Message: Volume ID: 123456789

From = Kartin SchollZHIPAAS uite.com

T 'ﬂfﬁ- E.pﬁ&’dllﬂ Lom
CL...

Send

Bec...

Subject: [HIPAA Premium Payment Master [TEDCFSEF]: Request for Trial License Ex
Request for Trial License Extension

Product: HIPAA Premium Payment Master
Volume ID: 7EBDCFSBF

Already licensed features:
Image Creation,

File Creation,

Work with Database,
Claim Entry/Edit

Required new features: No new features selected to request for license

Current Key:
Trial Key: EIRNO-QOPOO-GHFIF-KBMSP-5A48Y-EGIBI-6D3WIKS

The trial extension request email
6. The response from the support team should includes an activation key.

7. 0nce you have the activation/unlock key, click "Register” on the program welcome
window.
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HIPAA Premium Payment Master
20
Day(s) remaining for trial o

This software is for evaluation purposas only and has limited
functionality
‘fou will have to purchase this software if you want to continue using it
after a free evaluation has expired.

B4EC5448 Ask fortrial etension | Order | Regster |

The "Register” button

8. Paste the activation key into the field on the Registration Form and then click

"Register.”

Tip: The field is case sensitive. The best thing to do is to copy and paste the License Key from our email.

HIPAA Premium Payment Master

x]

Regster |

Closs

The "Registration Form" window with entered license key and highlighted "Register” button

9. The success message will appear in the "Result” border. You will see what components

have been registered.

© <2006> ... Martin Scholl Consulting, Inc.



Getting Started 27

— Redt

Thark pou for evalusting HIFAA Premium Payment Masted
Thiz iz & full functional veron of HIFAS Premium FPayrment Master for evaluation use only.
Thes evaluation verzion expres in 15 days

EDI_Exchange component i ot registened

The license activation result

Click "Close."

10.0nce the license key has been entered, click "Try" on the welcome window to continue
using the program for another 14 days.

Q cense x|

HIPAA Premium Payment Master

20
Day(z) remaining for trial 0

This software is for evaluation purposes only and has limited
functionality
You will have to purchase this software if yvou want to continue using it
after a free evaluation has expired.

B4EC5448 Ty | oder  |[ Regster |

The "Try" button

Once the product is registered with a permanent unlock code, future upgrades will find
this key and install without user action.

3 Configuring the Application

3.1 Configuring Program Options

1. To configure the program options, select Setup » Application Setup in the main menu.

t HIPAA Premium Payment Master - 64bit

wp ['log EDIExchange Help

=

Companty Setup

The "Application Setup” menu
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Alternatively, you can click on the "Setup” button located on the main toolbar.

':iHlPﬁﬂ. Premium Payment Master - B4bit

File Wiew CodeSets DataBase Image Setup Log EDIExchange Help

. » =& RO 0T

The "Setup” button

2. The following screen will appear.

Application Setup E
Proceszsed Files

" Leavein Place " Mowe " Delete

Aoved File Director

C ]

i Outbox Directory Path

I 1

~Log i Document Color

: On Screen  On Paper
™ Write alweays o lo
. 9 &~ Red " Red
“pdate  Black  Black

™ Mevar check for update

Save Help I Close |

4

The "Application Setup” window

You can configure the options:
* Processed Files
e Outbox Directory Path
e Log
e Update
¢ Document Color

Read the detailed descriptions further.

3. Once you have finished editing the options, click "Save.’
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Processed Files

In order to prevent the duplicate processing of files, the HIPAA Premium Payment Master
can move or delete files after they have been processed. Since the program can be
launched by the Window's scheduler (see Running the Application via Scheduler ), it is
important to either move or delete processed files, so that they will not be picked up
again. You have the choice to either do nothing, move the processed files to a specific
folder or delete the files:

e Leave in Place — Select this option to do nothing with processed files.
Tip: This option is not recommended.
e Move — Select this option to move the processed files to a specified folder.

e Delete — Select this option to delete the processed files.

Outbox Directory Path

Define the destination folder where the result files will be stored.

Log

e Keep a log of every file processed - Determines whether the log entry should be
created for each file processed. By default, the log is only active in command line use
(without human interaction.) If you want a log entry created for each manual
processing, except viewing on screen, place a check mark here. See also: Accessing
Logs.

Update

e Never Check for Update — To check the HIPAA Premium Payment Master version
update, uncheck the "Never Check for Update” check box. If the check box is
unchecked, the application will automatically look for the new version available and a
pop up window displayed. On selecting the new version, the application will get updated
to the current version available. The lower right corner of the application window
displays information including alerts on version updates.

No update available .:

The message on the bottom bar
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3.2

Document Color

This section of the setup window is concerned with the output colors. You have the choice to

render the form in red or in black. The form background can be set to red to make the form
visually more appealing and to allow the use of a color filter for OCR software. The color can

be selected for the following media:

Note: The data is always black.
e On Screen — Choose a color for the form when displaying payments on screen.

* On Paper — Choose a color for the form when printing payments.

Selecting a Printer

If you want to print to a printer other than the computer's defined default printer, you will need
to select the desired printer. See also: Printing Payment Records.

Note: The HIPAA products of the latest versions do not need anymore third party software for the
creation of image files. Older versions needed the Peernet Tiff Image Printer or PDF Image Printer
driver installed.

Follow the instructions below.

1. Go to File » Select Printer in the main menu.

@ HIPAA Premium Payment Master - 64bit

| File | Wiews CodeSets [DataBase Image  Setup
Cpen Sample Files
Cpen l
Cpen Directory
Import CHEX, File
Select Prinber
Exit |
The "Select Printer” menu item
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The "Printer" window will appear. Select the necessary printer.

Prink
i Printer
Neme: RSN |  Fropeiies..
Statuz:  Ready
Type: Rermote Dacktop E ssy Print
‘Whete:  TS001
Comment: I Piint to file
i~ Prinkt range ] Copies
= Al Mumber of copies; |1 E
o A I : -
23 23 F
& 1 1 L=k
ok | cawel |

Selecting the Printer for output on paper

Though you do not have any documents in your print queue, click on "Print" to select this
printer for future output.

3.3 Accessing Logs

The HIPAA Claim Premium Payment Master can log its activities. The logs are especially
helpful when running the program automatically through the scheduler (see Running the
Application via Scheduler).

Notice: To log the activity, activate the "Log All Processing Except Viewing” option. See Configuring

Program Options.

In case of any problem, the first thing is checking the log, where all actions and all error
messages related to an EDI file are written down and saved.

Follow the instructions below to access the log files for your HIPAA Premium Payment
Master.

Click View » Daily Log in the main menu.

& HIPAA Premium Payment Master - G4bit

File ‘Wiew (CodeSets DataBase Image Setup | Log |' EDIExchange  Help
| - i
—

= f 2 Dy Log ==
S e i

The "Daily Log" menu
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Log files are simple text files, one for each day that are stored in date hashed folders.
Alternatively, access the Logs folder in the following directory:

Windows XP: c:\ Docunents and Settings\All Users\Application Data\H PAAsuit e\ Hl PAA
Prem um Paynment Master\Logs

Windows 7, Vista: c:\ ProgranDat a\ Hl PAAsui t e\ H PAA Preni um Payment Master\Logs

P\ )| - Locol Dk (C:) ~ ProgramData - HIPAAsute - HIPAA Premim Paymenk Master - Logs ~ 2013 - November v &

Organize *  Includein ibrary = Sharewith =  Burn  Mew Folder

- Eavories Name - Date modiied Type | size

B Deskkop L 2013111200 11122003 9:54 AWM Text Document 1 KB
& Dowrloads

1| Recent Places

The Logs folder in Windows 7

Tip: The folder is hidden by default.

Tip: The Pr ogr anDat a folder contains all your application data, like program settings, user data, etc,
for all of the installed programs on the computer. The Progr anDat a folder holds the same files that
were contained in the\ Document s and Settings\All Users and \ Documents
and Settings\All Users\Application Data foldersin XP.

Within the directory, find a folder for the year you are looking log for. Then find a sub-
folder for the necessary month with files for each day. Double-click a file which has the
name equal to the necessary date. The log will look like this:

Transaction Log

| Tuesday . November 12,2013 x| Get Log

| Cutput folder for imanes is not set!
Proceszzing of the file 820_3 ad began af 110 22093 53540 AM
Premium Payment Images will be created
1 Records have been processed
The file TNE20_3 pdf has besn created
1 Premiun Payment Records hive béen imaged
Processang of the fie §20_3 edi ended af 1101202003 33541 AM

Processing of the fie 520_3 adi began &l 110 22013 35447 &AM
Premium Payment Images will be created
1 Records have been processed
The file Teoutpud820_34if" has been created
1 Premium Payment Records heee been imaged
Processing of the file 820_3 edi ended ot 111 202013 9:54:47 AM

The transaction log for a specific day
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3.4 Using the EDI Viewer and Editor
EDI files are often hard to read, especially if they have no carriage returns and line feeds
to put each segment on a line of its own.
The EDI Editor available in the HIPAA Premium Payment Master replaces all element
separators with a star ™", all sub element separators with a colon ":" and all segment
separators with a tilde "~" even if the original file uses different dellmiters.
Tip: Changing EDI files can be a tricky undertaking. You should be experienced in the format of the 820
and understand that an 820 payment file could be a legal document that should not be altered without
the consent of the originator.
To Open EDI Editor
To access the EDI Editor, select the "EDI Editor” option under "View" menu item.
"HIF‘HR Premium Payment Master - 64bit
DMpul Mode
" Printer
{¥ Screen
T Image
The "EDI Editor” menu
Note: This option is only enabled when you have opened an EDI File.
Alternatively, you can click on the "EDI" icon on the toolbar to invoke the EDI Editor.
:‘HlPA.n. Premium Payment Master - B4bit
File Wiew CodeSsts DataBase Image Setup Log EDIEwchange  Help
= f — % - L,
-y A9 0%
~— Dutput Mode
" Printer
(* Scresn
" Image
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The "EDI Editor” button

The following screen will appear:

1 ISAT0D* 0o~ ZTRIZETTOCE  *307999 030224*1216*U 00407 0000000040 T ;[I
2 (‘.:i'gnz.ﬂa'%EFEDER CODE*RECEIVERCODE®19940331"08021*X*004010X061™
3 51820 -~
4 BPR*U20000.00°C*ACH*"CCP*01"934257813 DA 1234587°1231555555 01025677833 DA99887 766 19970620™
5 TRN*3*12345%1231555555™
6 REF*18"673001™
7 REF=2F 0004369123~
& DTM=008*19970618™
9 DTM*035*19970619™

10 M1*PE*DEF HEALTHCARE CO"1*998216353™

11 H1"PR"ABC PLASTICS"1"000057311™

12 ENT*1*2J*34*190206123™

MMT*EY*1*SMITH"JOHN™"E[*123456™

14 RMR*CT*190206123*P*7000.00™

15 ENT"2"2)"34"163910163™

16 NMT*EY*1"JONES"MARY™EI*793016™

7 RMR*CT*163910163*P1*10000.00*11000.00™

15 ADM*-100.00"52™

19 ENT*3"2J%34*179203456™

20 NMTEY*1*JOHNSON=JOE™E|*334213~

21 AMR*CT*179203456*P1~30™

22 ADX*-100.00*52™

23 SE=21"0002™

24 GEM ™1™

25 IEA1"000000905™

3

wd

The EDI Editor window

To Cut, Copy, Paste

When you right-click anywhere in the text, a context menu will appear with typical test
edit options such as cut, copy and paste.
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h

REF*18*673001™

7 RI F.EF'@ Undo

DTM*005*195

DTM*035*199 Cut

N1*PE*DEF H *1*995216353™
N1*PR*ABC 8 pacta 57811

ENT™1*2J%34
NMTEY*1°g] Deete *123456™
RMR*CT*190 Select 0™
ENT=2"2J"34 o
MM]*I:E:YT']I% Find
RMR*CT* Reylace
ADX*-100.00°
ENT™3"2)"34'  Go to Line...
20 NMT*EY*1*JORANSONJUE ™
21 RMR*CT*179203456*P1=30™
22 ADX™-100.00~52~

23 sE*21~0002™

24 GEM1M1™

25 |IEA1*000000905™

?':-l

WO o5

i

l..l: -h _4 r._: =

E*793016™
).00%11000.00™

5 08 = o

“EI"934213™

The context menu

To Find and Replace

35

The "Find" and "Replace” utilities work as in a common text editor. To use them, right-
click somewhere in the document and then from the displayed context menu select the
"Find" or "Replace” command. Alternatively, you can press & rl F simultaneously on your

keyboard to bring the text search utility.

Fnd 21|

Fadet |
Direction Cancel |
[ Maich gase Lﬁ Up ' Down |

The "Find" pop-up

Pressing ar1 Hsimultaneously will bring up the "Replace” utility.

Fedwhat |
Reglace with: |

™ Matchgaze

The "Replace” popup

To Save the Changes

As long as you don't save, there will be no changes to the file.
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If you make changes to the file, the "Save" button becomes enabled and you can save any
changes. The HIPAA Premium Payment Master will further work with those changed files,
so you don't have to open the file again.

Notice: Changing EDI files can be a tricky undertaking. You should be experienced in the format of the
820 and understand that an 820 payment file could be a legal document that should not be altered
without the consent of the originator.

[ File: 820_d4.edi =1 &=
Help Save |
SAMD0" 0o~ “ZZ*TRIZETTOCE "20"999 "030224*1216"U"00401*000000004 0T ;I

20 ‘:.‘-'.'BR:.Z.?-.:‘%EEIEDER CODE*RECEIVERCODE*19840331"0802*1*X*004010X061™
ST*R20%0002~

b BPRAU20000. 00 C*ACH*CCP* 0193425781 3" DA 23458 71231555555 01025677833 DA39887 766" 19970620™
THN"3"12345"1231555555™

The "Save" button

3.5 Setting up the Company

Creating EDI files will include a lot of information on you and your trading partners. The
company setup screen is designed to enter all the necessary information for the EDI
creation.When you create EDI files there are a few elements needed to identify your
company as the sender, the producer of this EDI file. For this matter, use the company
setup screen. You can specify your company information and other settings related to
your company there.

If you have the EDI Exchange component licensed then all this information is stored in the
data file "COMPANY_SETUP". If you don't have this component then this information is
stored in the Windows registry.

Note: You need to configure the database first. See Setting up the Database Connection.

1. To configure the company, select Setup » Company Setup in the main menu.

Z‘HIPA.II. Premium Payment Master - G4bit
File Wiew CodeSets DastaBase Imagel | Setup | llog EDIExchange  Help

Application Setup b ::l:r:,

" ; : |
1 A Al [ 3]

The "Company Setup” menu

2. The following screen will appear.
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Company Setup

=10l =]

“ Indicates Mandatory Felds

Save

Company Information
Name  [COMPANY : ISA Segment Sender ldentifier  [TEST-ID )
Address1 | Qualifier |22 - Mutually Defined Eh
Address2 | Application Sender's Code GS_2 JTESTCODE .
Gty nv : Tax ID [rEsT-D -
State |NY - New York j .  Plan ID  Payor ID |
- Three letter identifier to prepend
B | Plus 4 [ to all outgoing EDI files I
— Contact Information ISA 14 and 15
Contact Person | JOHN SMITH EDI Files will be:
Telephone [i212) 1234567 = Ex Fax J_ ) - € Test " Production
E-Mail |.JOHN@GI‘u'IAJL comMm * | |[T Acknowledgement (TA1) req.

Cancel |

The "Company Setup” window
3. You can configure the following options:
e Company Information
e Contact Information
® ISA 14 and 15

Read the detailed descriptions further.

4. Once you have finished editing the options, click "Save."

5. The following success message will appear. Click OK.

B x

Compary Data Saved Successfuly

[

Company Information

e Name — Company name. Obligatory option.

e Address 1
e Address 2

e City — Obligatory option.
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e State — Obligatory option.
e ZIP
e Plus 4

¢ |SA Segment Sender Identification — It is the most important option to choose. It
identifies your organization for all EDI transactions. Most commonly the Qualifier
"ZZ" and a free form ID up to 15 character in length is chosen. Other options include
your tax ID and the Dun & Bradstreet ID.

¢ Qualifier — The ISA Identifier and qualifier are the unique key to the trading
partner database file. The ISA identifier can be up to 15 bytes long, the qualifier
has to be 2 bytes. Approved qualifiers are:

e 01 Duns (Dun & Bradstreet)

* 14 Duns Plus Suffix

e 20 Health Industry Number (HIN)

e 27 Carrier ID Number (ldentification Number as assigned by HCFA)

e 28 Fiscal Intermediary ID Number (ldentification Number as assigned by
HCFA)

* 29 Medicare Provider and Supplier ID Number (Identification Number as

assigned by HCFA)
e 30 U.S. Federal Tax ID Number (ldentification Number)

e 33 NAIC Company Code (National Association of Insurance
Commissioners Company Code)

o 77 Mutually Defined

e Application Sender's Code GS_2 — The option represents the program or machine
that created the file. Usually the same as the ISA Segment Sender Identification.
You can select other ID if you need. Obligatory option. The GS_02 identifier is
usually the same as the ISA identifier but you can also choose some other ID. It
represents the program or machine that created the file, but the most common is
a repetition of the ISA identifier.

e Tax ID — Obligatory option. Also called an Employer Identification Number (EIN).

e Plan ID / Payor ID — Fill in your Payer ID and Plan ID if you have one; this is only
important for the 271 and 277 transactions. Optional setting.

e Three letter identifier to prepend to all outgoing EDI files — Optional setting.
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Makes your files easily identifiable.

Contact Information
The contact information goes into the PER segment of outgoing transactions:

e Contact Person

Telephone
e Ext

e Fax

E-mail

ISA 14 and 15

¢ EDI files will be — ISA element 14 determines if the resultant file contains test or
production data:

e Test
¢ Production

e Acknowledgement (TA1) req. — ISA element 15 indicates whether you want a TA1
acknowledgement for files that you send out.

3.6 Selecting a Code Set

EDI relies on transaction code sets. These codes represent longer explanations and
descriptions. At the onset of EDI one of the main design ideas was to make the EDI files
as short as possible and to allow different languages to use the same descriptions by
reducing long verbose explanations to 2-3 byte long codes. Computer storage was
incredibly expensive and making any file larger than it absolutely had to be was
considered wasteful.

At the onset of EDI one of the main design ideas was to make the EDI files as short as
possible and to allow different languages to use the same descriptions by reducing long
verbose explanations to 2-3 byte long codes. Computer storage was incredibly expensive
and making any file larger than it absolutely had to was considered wasteful.
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The code sets are stored in the file codesets. xm in the confi guration subdirectory:

Windows XP: c:\Documents and Settings\All Users\Application Data\H PAAsuit e\ H PAA
Prem um Payment Master\ Confi guration\

Windows 7, Vista: c:\ ProgranDat a\ Hl PAAsui t e\ Hl PAA Premi um Payment Master\ Confi guration
\

. Configuration

P )| - Computer - Local Disk (C:) - ProgramData - HIPARsuke ~ HIPAA Premma Payment Master ~ Configuration

Organize ¥  Inchude in bbrary =  Sharewath =  Burn  New Folder

¢ Favorites Name ~ Date modifed Type

B Ceskbop | Codasets, i 11/4/2013 12531 M ¥ML Document
& Downlosds

- Recenk Places

The Configuration folder in Windows 7

Tip: The folder is hidden.

To view/edit transaction code sets in HIPAA Premium Payment Master, follow the
instructions below.

1. Go to the "Code Sets" item in the main menu.

:‘Hlpﬁﬂ. Premium Payment Master - B4bik

File Wiew!| CodeSets |/DataBase Image Setup Log EDIExchange Help

—_— AtoE ks, i oty
I - FtoP  » / a “) @ '."

The "Code Sets" menu

2. From the sub-menu, select a code set name. The following menu items are available
via the "Code Sets" menu:

AtoE
¢ Credit Codes
¢ DFl Codes
¢ Date Codes
e Entity ID Codes

FtoP
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e Handling Codes

¢ ID Codes

e Pay Adjustment Codes

e Payment Action Codes

e Payment Format Codes

e Payment Method Codes
QtoZ

e REF Codes

e Report Transmission Codes

e SAC Codes

e Unit Codes

The following screen-shot illustrates how to select the "ID Codes" for display.

:‘Hlp‘.ﬁ.ﬁ. Premium Payment Master - bd bt

File Wiew (| CodeSets || DataBase Image Setup Log EDIExchange Help

L - —
| Manding Codes - hf @ i §
ID Codes |

Pay Adjustrent Codes
Payment Action Codes

Paviment Format Codes
Payment Method Codes

The "ID Codes" sub-menu

3. The code set configuration window will be displayed.
You can add, delete or edit codes. Read further how.
Below you can see this window for the ID Codes.

The window provides the following information:

e Number of records in codeset — The total number of codes. For example, for ID
Codes it is equal to 31.
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e Codes and their corresponding descriptions. The codes are indicated in the source
EDI files. The descriptions are displayed instead of codes in the result easy-to-read
files. For example, for ID there are the following codes and corresponding

descriptions:

e 1 — D-U-N-S Number

9 — D-U-N-S5+4 Number
21 — Health Industry Number

24 — Federal Employer ID

* etc.
ID Codes MNumber of records
in codeset
Save Close Help 31
Code Deszcription =
b 1 D-lJ-M-5 Mumber |
9 C-L-M-5+4 Mumber
.21 .Heahh Industry Mumber
_24 _FsdsmlEmpID}‘er (]
n Bank 1D Code
.34 .ESN
46 (ETIN
_5? _Depanmenl
58 Operating Comparny
| 75 | State or Province Azzigned Mumber =
_Eld _Assigrled by the arganization
A3 Azgigned by Third Pary
| 44 _Assignsd by Cleannghouse
| A |FINS Number
A0 Blue Cross Blue Shield ID
_01 _Insured or Subszcnber
_OF _Can-udian Financial Institution Routing Mumber |
£ L At 1F hdl o4

The "ID Codes" configuration window

4. Click on the "Save" button to save the changes.

Adding a New Row

To add, click on the last row. Now you can see the indicator in the first grey field.
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Fi . Payor 1D
_F"F' :Fharm-acy FProcessor Mo
=1 Service Prov. Mumber
.X".-" | HCFA Plan 1D
XX NP
(2] _

The indicator

Click the field again to enter to the Edit mode. Now you can enter the text.

Note: Only after you leave this row, the changes will take place.

Deleting a Row

To delete, click the left margin. This action will highlight the whole row.

=] Pharmacy Processor Mo
sV Service Prov. Nurnber

x HCFA Flan ID

Highlighting a row by clicking the left margin

Now press the <DELETE> key on your keyboard.

Editing the Row

To edit, click two times the cell you want to change. Make your changes. Clicking or
moving outside this cell makes the changes to be "sticked.”

Notice: Don't forget to save the changes by pressing the 'Save' button.

4 Creating Image Files and PDFs

4.1 Creating Image Files from EDI

The greatest disadvantage of electronic payments is that they are near impossible to be
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understood in the raw form. Storing an image associated with a payment makes a lot of
sense for the most HIPAA Premium Payment Master's users. If you have an investment in
a payment imaging system, you can now create images from EDI files and treat them in
your imaging system just like scanned images from paper payments. If your staff can
understand a payment on a UB04 in a second, why not make it available in this form?
Having an image file makes it possible for case workers to call up an image of the
payment in seconds.

The HIPAA Premium Payment Master can be used to create image files and PDFs of the
EDI payments. Image file creation is a component that can be licensed separately.

The HIPAA Premium Payment Master displays the EDI document in a page that makes it
easy to read the 820 transactions.

Note: Earlier versions of the HIPAA Premium Payment Master used a third party image printer driver.
This is no longer necessary. The HIPAA Premium Payment Master now has PDF and TIFF capabilities
built-in.

Certain parameters of the formats are adjustable.

You can create image files containing the data that you see in Screen mode. You can
create image files manually or automatically using the command line arguments and
Windows Scheduler. Read more in:

e Running the Application via Scheduler

Before creating image files, make sure all settings are defined correctly. Read more in:

¢ Doing Image Setup

e Adjusting Image Options

How to Create Image Files

Follow the instructions below to create an image file from EDI file.

Notice: The image file will be created based on the pre-defined settings. Read more in Doing Image
Setup, Adjusting Image Options.

1. Open an EDI file or directory containing the EDI files in the HIPAA Premium Payment
Master. Read more in Processing an EDI File, Processing an Entire Directory.
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8 HIPAA Premium Payment Master - G4bit
File Wiew (CodeSsts DataBase Image Setup Log EDIExchange  Help

| File | Wiew CodeSets DataBase Image

Open Sampbe Files
&% Open

[ oentveior |

Irnport CHEX, filis
Seleck Prirger

Exit
The "Open Directory” menu

2. Select the "Image File" option in the "Output Mode" block.

:.‘ HIFAA Premium Payment

File View CodeSets De
=B
B ||

— Dutput Mode:
" Prinker

I Screen

| & lmage

The "Image File" mode

3. Click on the "Run” button.

45
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* HIPAA Premium Payment

File  View CodeSets e
i (>) = |

- Dutput Mode
" Prinker

" Screen

*  |mage
[ Data Import
— Counter

[F'uyment Count

Run ?

The "Run" buttons

4. The "Processing Results” window displays the report. You can find the resulting TIFF or
PDF files in the specified folder.

Processing Results
Processing of the file 320_3.edi began at 1112/2013 5:33:40 AM
Framium Fayment Images will be created
1 Becords have been processed
The file 'DWE2Z0_3 pdf has been created
1 Premium Payment Records have been imaged
Fracessing of the file 820_3.edi ended st 11122013 5:33:41 AM

The "Processing Results” window

4.2 Doing Image Setup

Before proceeding with image export, do the image setup as described further.

Select Image » Image Setup in the main menu to access the "Image Setup” window.
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& HIPAA Premium Payment Master - G4bit

File Wiew CodeSets DataBasel | Image '__‘_-Ietl_p Log EDIExchangs Help

J . Imnage Viswer L : By
i A (O
| Output Mode ‘ Image File Options |

The "Image Setup” menu
The following window will appear:

Image Setup | _ O]

Image File Location
Qutput Directory For Image Files

Image folder options Image Format

* None & TIFF Format FDF Format
" Sub-Folders for Year, Month and Day
" Sub-Folders for Year and Week

" Sub-Folders for Year and Day

Save | He-lp.n | Cancel .Ié

The "Image Setup” window

Color On Images
* Red " Black

You can set the options described below.

Once the options have been set, click "Save."

¢ Image File Location — Determine the destination folder where the images will be
stored.

¢ Image Folder Options — When you create a lot of images, it is important not to
place them all in the same folder. Microsoft Windows has issues handling more than
1000 files in a folder. That is the reason why the HIPAA Claim Payment Master can
hash the image files over many sub-folder. You have the following choice to use:
* None — Default value.

e Sub-folders for Year-Month and Day — The sub-folders will be created within
the Image File Location. Example: \ 2012\ Febr uar y\ 29\ .

e Sub-folders for Year and Week — The sub-folders will be created within the

Image File Location. Example: 2012\ 9\.

e Sub-folders for Year and Day — The sub-folders will be created within the

Image File Location. Example: 2012\ 20120229\ .
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4.3

¢ Image Format — Choose whether to create PDF or TIFF files.

e Color on Images — You have the choice to present the document black and white or
have form elements in red. You can set this separately for screen, paper or image

files.

Adjusting Image Options

Before proceeding with image export, do the image setup as described further.

Select Image » Image File Options in the main menu to access the "Image File Options”

window.

@ HIPAA Premium Payment Master - 64bit
File iew CodeSet DataBasel| Image | Setup Log  EDIExchange  Help

Image Viswer

>y | e

| ~ Dutput Mode
The "Image File Options” menu

Inage Setup

The following window will appear:

Image File Options _____|

B,

-t

— Dptions for TIFF ;
lor th; Cormpression: Image Resolution:
" Blackiwhite & LZw Horizontal resolution: 200 dpi
i
T 4bpp " Packbits . T §
' c Gl
8bpp _ ¥ Vestical Resobution = Horisontal Resokion
* 24 bpp e~ R Verical resolution: 200 dpi
" 32bpp "CITT 1.6 |
— Dptions for PDF Sel deiult values |
™ Use content COMPression
Save | Cancel )L

The "Image File Options” window

You can set the parameters for image file creation; they are described below.
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Once the options have been set, click "Save."

Options for TIFF

Here you can adjust the settings of the Image files.

e Color Depth — You can change color depth of the image (black / white, 4 bpp /
8bpp / 24bpp / 32bpp).

Note: TIFF in Window's GDI library does not work with 16 bpp (bits per pixel). Color depths set lower
then 16 bpp results in some losses in image quality.

Reference: The black-and-white (bi-level) image means that for each pixel (picture element) in the
image we do not need three bytes as in the true color image (over 16.7 million colours), but only one
bit that is 1/24 part of the pixel size from the true colour image. The one-bit pixel can express only
black or white colors, nothing more.

e Compression — You can use compression with TIFF files: LZW and Packbits are used
for all Colors, CCITT4 for black-and-white.

e LZW — You can compress any type of TIFF image of any bit depth using LZW, a
lossless method. The application can store the compressed image in a TIFF 5.0
file or keep it in memory. An average 2:1 compression ratio is achieved with
LZW compression on images.

e Packbits — You can compress and decompress gray scale, palette, and bitonal
images using Packbits, a lossless method. Packbits are fast, widely-supported,
and provide good compression of sparse images, such as scanned documents.
The application can store the compressed image in a TIFF 5.0 file or keep it in
memory.

e Photometric Interpretation — For the black-and-white and grayscale images (when
"Black/White" or "4 bpp" options are selected as color depth), you can specify the
intended interpretation of the image pixel data. Select one of the following options:

e White is Zero — The minimum sample value is displayed as white.
e Black is Zero — Default value. The minimum sample value is displayed as black.

¢ Image Resolution — You can change horizontal and vertical resolution of images
from 96 to 300 dpi (dots per inch). Default resolution is 200 dpi. The same rule
applies here: the larger the Resolution, the more computing time and power is
consumed and the larger the image file sizes.

Note: Theoretically we could use even higher resolutions, but it will slow down processing significantly
result in approximately the same result in quality.
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4.4

Options for PDF

e Use Content Compression — Checking this option does result in considerably smaller
files. You can choose the option to compress the content, thereby reducing the file
size by roughly 50%.

Viewing Image Files

The HIPAA Premium Payment Master has a built-in image viewer that uses light weight
DLLs to display TIFF and PDF images. It also allows you to navigate through the folder
structure that has been set up.

Select Image » Image Viewer in the main menu to access the "Image Viewer" window.

'i-.Han.n. Premium Payment Master - Gabit
Fle Wiew CodeSets DataBase (| Image :___Seh.p log EDLE

> | o [

Image Setup
‘ Image File Options

| — Dutput Mode -
The "Image Viewer" menu

The following window will appear:

Image Viewer
1/1

) output P o - e

Premium Payment

ABC PLASTICS DEF HEALTHCARE CO |1
DOCGETEI1 bor  PRRZ1EIS3
¥ ARA Routing B 034257813 ABA Reuting & DIEETTEN)
L e tho EEpETTES

o Spin Paymert and Bemittance
31555555

CRTOMBT 1248 o E30,000.00
Credst { dutomated Cleaging Houses Canh [CCDs)
08 RNeeT 0EMW199T
* DOO4ME123
1 OrgafiEaien Summary Remitance (Corparation) oooosTIN
1 | Invoice Numbe COMAIEE1 23 $20,000.00
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The "Image Viewer" window

The Viewer lets you navigate through multi-page documents with the navigation buttons
in the upper left corner of the image. You can adjust the display size according to your
monitor size or preferences in the upper right corner.

The left panel lists all generated TIFF and PDF files. Click a file name to display its
content.

TIFF: Microsoft Windows has a Windows Photo Viewer that renders TIFF images.
Unfortunately, it is not that practical. It omits lines in lower magnification and makes
the image look sloppy, but is sufficient for most. There are much better TIFF viewers out
there but we will not make any recommendations.

PDF: PDF files can be opened with Acrobat Reader by Adobe which is available for free.
There are also other free PDF viewers and editors. We wil not make any
recommendations.

5 Using the Database

5.1 Exporting the Data

The HIPAA Premium Payment Master can export the data contained in a 820 EDI to any
ODBC-aware database such as Microsoft SQL Server, Oracle, AS400, etc. The information
is written to a database for further processing.

When you select the "Data Import" check-box, the options for Printer and Screen and
Image become de-selected. But you can select "Printer” and "Image” in addition to data
export again. Only screen and data import are prohibited because a user could at any
time interrupt the complete processing of the file.

The data is written to the database once the "Run” button has been clicked and only if
the "Data Import" checkbox is activated.

‘ HIFAA Premium Payment

File View Code Sets ¥
SN~

Output Mode
T Printer

" Screen

" Image

[ Data Import

© <2006> ... Martin Scholl Consulting, Inc.


http://get.adobe.com/reader/
http://get.adobe.com/reader/

52 The HIPAA Premium Payment Master

The "Data Import" check-box
The "Processing Results” window will display notification about data export.

=10 x|
Processing of the file 820_1.edi began at 11122013 11:35:29 AM

Pramium Payments will be exported

1 Records have been processed

1 Premium Payment Records have been expored to Live database

Processing of the file 320_1.edi ended at 11/12/2013 11:35:30 AM

The "Processing Results” window
The sequence of actions to setup the data export is the following:

e Setting up the Database Connection

e Creating Tables

e Selecting Fields to Export

* Browsing Exported Data

5.2  Setting up the Database Connection

The HIPAA Premium Payment Master natively treats a payment advice record as a single
object. The application extracts the complete payment from an EDI file into its
proprietary data object. It can translate and export this data into any ODBC-compliant
database such as Microsoft SQL Server, Oracle, etc.

Tip: The default fields that come with the product can be extended; customizations are possible.

1. Select Data Export » SQL Setup in the main menu.

& HIPAA Premium Payment Master - G4bit

File Wiew CodeSets'| DstaBase | Image Setup Log EDIExchange  Help

B > RN Q @ 7

Table Creation
~ Dutput Mode Stored Payments
| Prnbs Field Mappings
. Soman Create 520 ED] Files

The "SQL Setup” menu

2. You will be confronted with the following screen where you can set up the database
connection and enter the names of the database tables.
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Database Server Setup for OLE/ODBC Connection

~ HIFAAsuite's Claim Extract Capabilities

HIFAAsuite natrvely stores & Claim as a single Ohject
HIFAAsuite can extract the claim data and write those into &
normalized Database such as Microsoft SOL Server or [BM
AS 400, Customizations are possible. Ask Vendor for details
-C jon Py

Database Tyvpe

s SaLsener |

Database Senver Name

Test Connection
Database
™ Checked

Username

Password

Payment Header Table Name

|EDI_Payments

You can create the
Payment Detail Table Name tables througha
- separate screen
|E DI_PaymentDetail
Save Connection Information
cance |

 Fields to be
Header Detail

O TradrgPaitried D N [ PaymentiD [This is Header Table's Auto Key

O Filename O nswed D

O Fileession [ RemitanceReiType

O Transactionto [ RemitanceReference

O TraceType [ Paymentiction

] TRNOrignstinglDs [ Amourt

O HandlingCode: [ Eilledamount

O Totatmount [ OthedDQual

O Pavrnentethod [ OthedD

O PaymentF omat [ CoveragePeniod

O OriginatingDFIDGual [ Adwinistrativelnio

O OriginategDFIID [ ContractS erviceCharge

O Sendettccountlual O InsuancePremminta

O Sendetaccount [ ServiceCharge

O OriginatinglD [ Adimount

O OiiginatingS uppiCode [ AdReason

O ReceivingDFIIDGual [ MemberCount

] ReceivingDFID [ MemberUrit

O Receivertecount

O Effectivebate

O CunencyErititD

O CunencyCode

O Mastestccount

[ HOR_ClientRepotingCategony

CJHDA_Plartic

O HOR_Conzobdstednyvoice

O HOR_MasterFoicy

O HDR_ScheduleReference

CIHOA_Lockbax

[CIHOR Groupho =l

Select All | selectwone | Select Al Select Hone
1'You can change the Fieldnames
Test Configuration | [ Show selected Fields only Save Field Configuration |

£

The "Database Server Setup for OLE/ODBC Connection” window

Connection Properties

Tip: If you use ODBC for the connection, you will need to set up the ODBC connection first in the
Windows » Control Panel ¥ Administrative Tools » Data Sources (ODBC) setup screen. Setting up the
ODBC connection varies from database to database.

¢ 1ODBC Data Source Administrator

UserDSM  System DSN | File DSN | Drivers | Tracing | Connection Pooling | About |

Syctem Data Sources:
Name | Driver | Add.. |
iSenes Access ODBC Drver
HIPAAzuteMySOL MySOL ODBC 351 Duver Remove |
SOL_0ODBC SOL Server
Test Dirrves do Micrasolt Access ™ mdb) Configune.. |

on thiz machine, including NT services,

#An ODBC Spstem data sowrce stores information about how to connect to
the indicated data provider, A Sysiem data source i visible to all users

o ]

Cancel
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The ODBC Administration screen in Windows

Define the database connection properties:

Database Type — Select the type of the database from the drop-down menu: is
either ODBC or Microsoft SQL Server either with Windows Authentication or with

explicit credentials.
Note: If you need other types, please contact us for customizations.

e MS SQL Server — If you have a Microsoft SQL Server database, please select the
appropriate type. Older versions of SQL Server use server authentication, newer
ones use the integrated user management for Windows domains.

e MS SQL Server Integrated Security

e ODBC Connection — The HIPAA Premium Payment Master uses OleDB for
optimized connection to SQL Server, either with server based security or with
Windows Authentication.

Database Source Name — The database server is either the IP address or DSN of
the database server. Specify the database server name or DSN. Enter 127.0.0.1 or
"localhost” if the computer you are at has the database. In case of SQL Server, it is
the IP address or the name of the database server. For ODBC it is the Data Source
Name (DSN) that is defined through the ODBC setup in the Control Panel of
Windows; type the name of the predefined ODBC connection.

Database — Enter the database name under the above connection. Typically, this
field will be empty for ODBC setup.

Username — Specify the user name that has privileges to the SQL Server database.
Typically, this field will be empty for ODBC setup. There, your log-on credentials to
the computer will be used.

Password — Specify user's password. Typically, this field will be empty for ODBC
setup.

e Payment Header Table Name — Enter the name that you give to your Payment

header table. The default name is suggested but can be changed.

e Payment Detail Table Name — Enter the name that you give to your Payment

Detail table. The default name is suggested but can be changed.
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Database Server Setup for OLE/ODBC Connection A.IQ.IEI
~ HIPAAsuite’s Claim Extract Capabilities  Fields to be exported
HIFAAsuite natrvely stores & Claim as a single Ohject Header Dretail
HIFAAsuite can extract the claim data and write those into & O TradrgPaitried D = [ PaymentiD [This is Header Table's Auto Key
normalized Database such as Microsoft SOL Server or [BM O Transactionio [ Ireswed D
AS 400. Customizations are possible, Ask Vendor for details O Filename [ RemittanceRefType
O HandingCode [ RemitanceReference
Production Connection I E;; activeDate anum
O Sendeaccoumnt [ OthedDQual
. Connection Properties O Receivertccount [ OthedD
Datab Type O Pavrnentethod [ CoveragePediod
- = O Mastestcoount [ Administrativelnfo
IODBC Connection :l O Preces:Date [ ContractS erviceCharge
Data Source MName |m ] DefveryDate = O InsurancePremiuminfo
IHlPMS uita{ O CoveragePencd [ ServiceCharge
TestC ) O CreationD ate [ Aditmount
Database O Receivaiams [0 Adfieazon
I r O ReceivelDQual [ MemberCount
Checked O ReceivedD [ MemberUni
Usemame [ Receivertddress
O Receiventddies:2
O ReceiveCity
Password O ReceiverState
I O RecerveaiZip
O ReceivetCouriry
Payment Header Table Name B :eceﬁersubdinvisim
EDI nits sceiveiPland
[FOL_Payme You can createthe. Dl DeivenCode
Payment Detail Table Name fables througha 8 Dekveryhlame
Y separate screen D einverCommbumber
EDI ntDetail
I _PaymentDetai D Payeetiame
[ PagerlDilual |
Select All [ setectione | Select AN Selectlione |
Save Connection Information
!You can change the Fieldnames
Help I Cancel Test Configuration | - Show selected Flelds only Save Field Configuration I

4

The connection properties fields

To create tables in your database, click on the "You can create the tables through a
separate screen” link. For instructions, refer to Creating Tables.
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— HIPAAzuite’s Claim Extract Capabilities
HIFAAsute nativehy stores & Claim as a single Object.
HIF&Asuite can extract the claim data and write those into a
normalized Database such as Microsoft SQL Server or IEM
AS 400, Customizations are possible. Ask Vendor for details

Production Connection l

-~ Connection Properlies
Database Type
|ODBC Connection =
Data Source Mame
[HIPAAsuite]
Test Connection
Database
| I Checked
Usemame
Password
FPayment Header Table Name
[EDI_P&yment-s e ,
Youcan create the
Payment Detail Table Name lables fiwougha

|EDI_Pa;-,-'mE| ntDetail %

Save Connection Information

Help |

Cancel |

A link to create tables

Once the connection parameters have been entered, click "Save Connection Information.”
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— HIPAAzuite’s Claim Extract Capabilities
HIFAAsute nativehy stores & Claim as a single Object.
HIF&Asuite can extract the claim data and write those into a
normalized Database such as Microsoft SQL Server or IEM
AS 400, Customizations are possible. Ask Vendor for details

Production Connection l

-~ Connection Properlies
Database Type
|ODBC Connection =

Data Source Mame
[HIPAAsuite]

Test Connection
Database

| I Checked
Llzemame

Fassword
|

FPayment Header Table Name
[EDI_P&yment-s

Payment Detail Table Name iablesfiwougha
|EDI_Pa;-,-'mE| ntDetail

( Save Connection Information L

Help | Cancel |

The "Save Connection Information” button

To verify if the entered parameters are correct, click on the "Test Connection” button.
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— HIPAAzuite’s Claim Extract Capabilities
HIFAAsute nativehy stores & Claim as a single Object.
HIF&Asuite can extract the claim data and write those into a
normalized Database such as Microsoft SQL Server or IEM
AS 400, Customizations are possible. Ask Vendor for details

Production Connection l

-~ Connection Properlies
Database Type
|ODBC Connection =
Data Source Mame
[HIPAAsuite] - ’
| Test Connection | |
Database S —
| I Checked
Usemame
Password
FPayment Header Table Name
[EDI_P&yment-s
You can create the
Payment Detail Table Name iablesfiwougha
separate screen

|EDI_Pa;-,-'mE| ntDetail

Save Connection Information

Help |

Cancel |

The "Test Connection” button

If the test has passed successfully, you will see the following notification:

Sucess ]
\i) Success estabishing connection

Paymenk Header Eable verified
Paymenk Detad table verified

The success message

Once the test has passed successfully, the "Not checked" message changes to "Checked."”

© <2006> ... Martin Scholl Consulting, Inc.



Using the Database 59

¥ Checked

The "Checked" checkbox

Once you have the database connection defined and tested, you can enter the table
names. See Selecting Fields to Export.

If you need to create the tables first, then see Creating Tables.

5.3 Creating Tables

For your convenience, the HIPAA Premium Payment Master has a tool that allows you to
create the database tables needed to complete the data export.

You can edit and save your database scripts to make them work for your specific
database.

Before data export, you need to create the tables through SQL table statements. You
can do it, using the built-in function of the HIPAA Premium Payment Master. Creating
these tables is a quite intimidating task. Once you have your connection defined and
tested, follow the instructions below.

Note: The tables are created via the "Drop Table" and "Create Table" commands. The scripts come
from files distributed with the application. Please, contact HIPAAsuite if you need help with the
database setup.

1. Select the Data Base » Table Creation in the main menu.

& HIFAA Premium Payment Master - G4bit
File Wiew (CodeSets || DataBase | Image Setup Log EDIExchangs  Help

= J SOL Sebup . : En,
LR [ Table creation jb‘ 9 O «
~ Dutput Mode SOFB PEpMSIEE

" Printer Field Mappings

(" Seiman Create 520 ED] Files

The "Table Creation” menu

2. The following window will be displayed.
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[ frmCreateTable

Payments Header | Payrrient Details | COMPANY_SETUP
Payments Table script:

[ Database
' Microsoft SOL Server T MySOL

£

= |

| CREATE TABLE [EDI_Payments]|
: [PaymentiD] [decimal]( 18, 0) IDENTITY(1.1) NOT MULL,

[TradingPartnerD] [varchar](15) MULL.
[FileName] [varchar](50) NULL.
[FileVersion] [varchar](12) MULL.
[TransactionMo] [varchar](50) MULL.
[TraceType] [char](2) NULL,
[TRNOniginatinglD] [varchar](10) NULL.
[HandlingCode] [varchar]{2) NULL.
[TotalAmount] [varchar]{18) MULL.
[FaymentMethod] [char](3) NULL.
[PaymentFormat] [varchar](3) MULL,
[CriginatingDFNIDCual] [char](2) NULL.
[OriginatingDFIID] [varchar](12) NULL,
[SenderAccountCiual] [char](3) NULL.
[SenderAccount] [varchar]{50) NULL.
[OriginatinglD] [char](10) NULL,
[OriginatingSupplCode] [char](9) MULL.
[ReceivingDFIIDQual] [char](2) NULL,
[ReceivingDFIID] [varchar]({12) NULL,
|[Receiver unt] [wvarchar](50) NULL
[EffectiveDate] [varchar](15) MULL,
[CurrencyEntitylD] [char](3) NULL.,
[CurrencyCode] [char](3) MULL.

Milantarf anasnd] honeabac S0 KL D

Compare Script with existing Table I

=i

Save | Execute St:rlptl

Close I
3

The "Create SQL Tables" window

3. Define the following options:

Database

¢ Microsoft SQL Server

e MySQL

Scripts

On the following tabs there are SQL scripts used to create the appropriate tables:

e Payments Header

e Payment Details

e COMPANY_SETUP
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Tip: You can modify the scripts so that they run on your specific database and to conform to your
database's specific SQL syntax. For each script, click "Save."

Save I Execute Script

Close
——

The "Save" button

For each script, click "Execute Script” to create the corresponding table in the database.

Warning: Executing the scripts will wipe out any previous tables that you created and you will loose all
data.

Save | Execute Script I:.

Close I
3

The "Execute Script” button

Once the table has been created successfully, you will see the following notification:

success Y]

Table successhully creabed

The success message

5.4  Selecting Fields to Export

The HIPAA Premium Payment Master can export all the fields. You might not want to
export every field, but only those that you have in your database. You are really only
limited by your database engine. In order to reassemble the payment from the database,
it is better to have all the fields selected and available.

Once you have created created your tables and tested connection and table names, you
can select which fields to export. Follow the instructions below.

1. Select Data Export » SQL Setup in the main menu.
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: HIPAA Premum Payment Masber - bd bt

File Wiew CodeSets DataBase'Imaga Setup  Log EDIExchange Help

e Q@07

~ Dutput Mode Stored Payments
| Prnba Field Mappings
| Soisan Create G20 ED] Files

The "SQL Setup” menu

2. You will be confronted with the following screen where you can set up the database
connection and enter the names of the database tables.

Database Server Setup for OLE/ODBC Connection

—HIPAAsUite's Claim Extract Capabilities  Fields to be exported
HIFAAsuite natively stores a Claim as a single Object Header Dietail
HIFAAsuite can extract the claim data and write those into a O TradrgPatned D -~ [ PaymentiD [This is Header T able's Aulo Key
normalized Database such as Microsoft SOL Server or IBM O Fiename O irswed D
AS 400. Customizations are possible. Ask Vendor for details O FileVeasion [ RemittanceRefType
O Transactionto [ RemitanceReference
O TraceType [ Paprentiction
O TRNDrignatingll [ Amourt
O HandlingCode [ Billedmaournt
O Totattmount [ OthedDQual
[~ Connection Properties O Paymentiethod [ OthedD
Database Tyvpe [0 PaymentF ormat [ CoveragePernod
[Ms SaL Server -] O] iiginatingDFIDQual ] Administrativelndo
O QiiginatngDFID [ ContractS erviceCharge
Database Server Name O Sendettccountfual O Inswancefremiuminfo
I O 5endesdccount [ SesviceCharge
Test Connection | [ OiiginatinglD [ Adimount
Database O DiiginatingS uppiCode [ AdReason
O RecevingDFIDOwa [ MemberCount
I " Checked ) ReceivingDFIID ] MemberLrit
Usemame O Receivertccount
O Effectivelate
O CunencyErntitylD
Password O CunencyCode
I O Mastethccount
[ HOR_ClientReportingCategon
Payment Header Table Name O HOR_Planbo
|EDI_Payments [ HOR_Consobdatedinvoice
“fou can create the CIHOR_MasterPoicy
Payment Detail Table Name tables througha CIHOR_SchedueRefecence
separate screen
EDI mentDetail O HOR_Lockbox
.[ P [1HDR Grouphlo =
Save Connection Information Socoar Eelect Hone | Etlert Eeloctlore |
'You can change the Fieldnames

Cancel | Test Configuration | [T Show selected Fields only Save Field Configuration |

The "Database Server Setup for OLE/ODBC Connection” window

A

3. The right side of the screen shows all the available database fields and columns. Choose
fields to be exported by selecting checkboxes in front of the fields in the following
tables:

Header
e TradingPartnerID
¢ Filename

¢ FileVersion
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¢ TransactionNo

e TraceType

e TRNOriginatingID

¢ HandlingCode

e TotalAmount

e PaymentMethod

e PaymentFormat

e OriginatingDFIIDQual
¢ OriginatingDFIID

¢ SenderAccountQual
¢ SenderAccount

¢ OriginatingID

e OriginatingSupplCode
e ReceivingDFIIDQual

® ReceivingDFIID

e ReceiverAccount

e EffectiveDate

e CurrencyEntitylD

e CurrencyCode

¢ MasterAccount

e HDR_ClientReportingCategory
e etc.

Detail

e PaymentID - Header Table's Auto Key
e InsuredID

e RemittanceRefType
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¢ RemitanceReference
e PaymentAction

e Amount

e BiledAmount

e OtherIDQual

e OtherlID

e CoveragePeriod

e Administrativelnfo

e ContractServiceCharge
¢ InsurancePremiuminfo
e ServiceCharge

e AdjAmount

¢ AdjReason

e MemberCount

¢ MemberUnit

Tip: We recommend to select all fields. This makes it possible to reassemble all the information in the
EDI file and create the image. You can click on "Select ALL" and then test the configuration. With the
scripts supplied with the application you should have no error messages.

Tip: Sometimes it might be necessary to rename a field or fields. Some legacy database want upper
case only or lower case only field names. The HIPAA Premium Payment Master allows you to rename
any field in any table. Click twice (not double-click) on a field and you are in "Edit" mode. Read more in
the following "Renaming Fields" sub-topic.

[OHOR_SchedulsRieference

a ock b
I HOR_Groupha

The field selection list in "Edit" Mode

4. Once you have made your selection or selected all you have to test your setup, click on
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the "Test Configuration” button.

B =10] x|
~ Fields to be exported
Header Detail
[#] TradrgPatredD [#] PaymentD [This is Header Table's Auto Key
[ Transactionto [#] IreuaedD
[ Filenarme [] BemittarceReiType
[¥] HandlingCode [#] RemittanceRefaence
[ T otakimount [#] Asreoari
Effectreallate [ Billeddsrcant
[ Sendetficcount [#] OtherdDQual
Receiverhccount [ OthedD
[ PanentMethod [#] CenverageFeiod
[#] Mastertizcount [#] Administiativelnio
ProcessDate [ CoritractS erviceCharge
[ DedrveryD ate [#] Irezunancefremiuminfio
CoveragePencd [#] Sesvicelharge
[ Creation ate [ Adirnount
[#] Receiveridams [¥] AdFieason
[ RreceivedDOual [E] MemberCount
[#] ReceivedD [ Memberlrit
Receivertddiess
[ Receiveriddiess2
[ ReceiverCity
[ ReceiverState
[ Receiveidip
ReceiveCountiy
R eceiverSubdnsion
[ ReceiverPianD
[ DekvesyCode
[ Delrveytd ame
D efrverpCommbumber
[ Paverhame
] P ayerlDQusl hd|
Select All | selectlione || SelectAl | setectiione |

~ !'You can change the Fieldnames

,f Test Configuration |\ ™ Show selected Fields only

Save Field Confiquration |

4

65

The "Test Configuration” button

The program will connect to the database and read the table definitions. Afterwards,
all the fields that you selected will be tested.

Notice: Before you can save your field configuration, you have to test the setup to make sure that all

the fields that you selected exist in the tables that you specified. The table scripts that come with
the HIPAA Premium Payment Master do not have all the fields because some of the fields are very

specific and not of use to many people.

You should receive a message like this. Click "OK."
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<

The success message

If there are errors, refer to the following "Troubleshooting Data Fields" sub-section.

5. Only after the configuration have been checked out, are you allowed to save it. Click
the "Save Field Configuration” button.

Important! After you have checked the setup and got the success message, you still need to save the
configuration otherwise nothing will be exported.

Select All Select Hone Select Al Select None |

[T show selected Fields only

'I'Iasliltnln'liﬁ;:ré;im; Save Field Configuration I

bl
S

The "Save Field Configuration” button

Renaming Fields

There are a few reasons why you would want to use different field names than the ones
given by the HIPAA Premium Payment Master:
e Your database cannot handle long column names such as "CA Clipper” or "IBM AS 400."
¢ You already have a staging table and want to import the data straight into your own
table which has different field names.

HIPAA Premium Payment Master lets you change the names of the columns that you
selected for export:
1. Check the box near the field for import.
2. Click the field name twice. Do not double-click, but slowly click twice. You will see
that the field name is now editable.

3. Change the name to your value and click somewhere outside the field.
4. Your field name has now been changed.
[#] CoveragePerod [#] CoveragePenod
Creationl ate | CreateD ate
[¥] Recenetame Changed to: [#] Recemetlame

Editing a field name

The new value will be saved as long as this field is selected for Import. If you unselect the
field and save your selection, the field will revert to its original name.
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Notice: Field names must not contain spaces.

Troubleshooting Data Fields

If fields don't exist in the database that you specified, you will see the error screen:

=10] x|
======= Tghle EDI_PremiumPayments ======= _I
Invalid column name 'Tota'.
Invalid column name 'Effective’.
Invalid column name 'Senderfccounts’.
Invalid column name 'PaymentsMethod’.
Help - Whal iz going on Uncheck Fields in Emor |
A

The "SQL Errors" window

Study the errors in detail and see what went wrong. In our case, for demonstration
purposes we have changed the names and that caused the error. A solution is to click the
"Uncheck the Fields in Error" button and return to the field selection screen.
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5.5

Felds to be exported
Header Table:
-] TradingPartnerlD
[ Traneaction Mo
[ Filename
-[¥] HandlingCode
-] Tota | Amourt
-[| Effective Date
-] SenderAccounts
-] ReceiverAccount
[ Payments Method
[ Masterfccount
-.[#] Coverage Period
.| ReceiverMame
[ ] ReceiverlD

The fields in error are now unchecked.

Browsing Exported Data

The HIPAA Premium Payment Master can access the exported data and show it to the
user. This might be helpful in tracking particular payments. You can work with the data
in the eligibility tables through the "Exported Payments" screen.

Select the Data Base » Stored Payments in the main menu.

:‘HIPAA Premium Payment Master - 64bit

File Wiew CodeSets(| DataBase |/Image Setup Log

B | X
- Table Crestion
~ Dutput Mode |: Storad Paymens |

. Prinkas Field Mappings

(" Scoean Create G20 EDI Fles

The "Payments in Database"” menu

You will see the following screen where you can see all the payments and review them.
Here you can compose your query using the fields in the database and conditions that you
select.

When you open the screen, it shows you the first record in the database and the screen
would let you scroll through all the records. You can enter your SQL query to select
certain records only either as free form query if you are experienced in the database
query language or through the "Define Query" tab.

In addition, you can query the database for any of the displayed fields. For example, if
you want to check if all the payments from a specific file were imported, you could type
the filename into the appropriate field and click the "Query" button. The results will be

© <2006> ... Martin Scholl Consulting, Inc.



Using the Database 69

returned.

5 Stored Premiums Payments

SELECT*
FROM EDI_Payments

Stored Eligibilitys | Define Query |

Clear Query l
Create 820 EDI File |

E T of4| b M | |
ID: |4 | auerv | Payer ld: 141737357 [Lauew |
ReceiverlD: (830463162 | Querv | Payer Name: |NYSDOH [Lauew |
Filename: [2011_R110206110814.1746 820- 00 x* | auery |
Receive Name: [SENIOR HEALTH CORP | avery |
PaymentlD D InsurediD RemittanceReflT RemittanceaRefe Amaount BilledAmount  OtherDQual

141797357 02932896 173.54

0.00

Help

Cancel l
2

The "Stored Premium Payments” window

You can use the "Define Query" tab to create a query.
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5.6

[# stored Premiums Payments .-EJE]-EI

|5E|-ECT . Execute Query

FROM EDI_Payments

WHERE Payerbame lke “.ALFA MEDAL CO% Clear |
Stored Eligibilitys  Define Query Ib Create 820 EDI File |

Field Use in query | Condition Criteria or =
DeliveryCode

DeliveryMame
DeliveryCommMNumber

PayerMame like
PayerAddMame
PayerDGual
PayerlD
PayerAddress
Payerdddress2
PayerCity
PayerState
PayerZip
PayerCountry
PayerSubdivision
PayerContact

PayerTel
PayerTelExt
PayerFax
PayerEmail
BankCode
BankMName

Help | Cancel

Stored Premiums Payments

e VA A M

KN [ T T T T T

Creating EDI Files from the Attached Database

Once the EDI Creation Feature is enabled, you can create the EDI files. Follow the
instructions below.

1. To configure the company, select Data Base » Create 820 EDI Files in the main menu.
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) HPAA Premium Payment Maser - o4 AN

File  View CodeSets | DataBase | Image Setup Leog ED

= > ¢ SQL Setup K@

Stored Payments

Output Mod Table Creation
@® Printer Field Mappings
@ Screen Create820 EDIFiles |

Delimiters Setup

) Image

The menu item to create EDI files under the "Data Base" menu

Alternatively, you can click the "Create 820 EDI File" button in the query builder (the
"Stored Premium Payments” window). Refer to Exporting the Data.

Stored Premium Payments

o e :
:
H 4|1 of 7| b Bkl
D- 1 Query Payer ID: 123456789 Query
Receiver ID: 012222222 Query Payer Name: ALFA MEDAL CO Query
Receiver Name: BATA INSURANCE CO. Query Filename: 820_2 edi Query
Payment Header: Payment Details:
Field Value i PaymentlD D InsuredID RemittanceRefType RemittanceReference
1 ﬂ ’ _1 030440093 16 555666

The "Create 820 EDI File" button located on the "Stored Premium Payments" screen

2. Clicking the button will bring up the "Create 820 Transaction Sets" window with the
query that you designed.
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(o= L =
1 SELECTTOP 20 *
2 FROM EDI_Payments

- Effective Date
10/30/2015 [~

| Select Trading Partner |

™ | Fields with 1 will be populated by the process.
[ Exit I Go! I Write to File |[ Send to Trading Pariner || View EDI File I Help ]
ISA segment
- ~ Password 1D Type Sender ID 1D Type Receiver ID Date Time - Interchange 1D Ack T/P -
00 ... 00 ... - - 151030 1500 = 00501 303150000 0 - T - :
GS segment ST segment
~ Sender Code Receiver Code Group Cortrol No ~ Version t Transaction 1D +
GS RA 20151030 1500 303150000 X 005010X218 v ST 820
1

3. After you have filled all necessary values, click "Go!"
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-

e oo L
1 SELECT *

2 FROM EDI_Payments

- Effective Date
10/30/2015 [~

| Select Trading Partner |

™ | Fields with 1 will be populated by the process.
[ Exit Il Go! ]| Write to File |[ send to Trading Partner | | View EDI File I Help ]
ISA segment
- ~ Password 1D Type Sender ID 1D Type Receiver ID Date Time - Interchange 1D Ack T/P -
00 00 ZZ ~ HIPAASUITE 7z -~ TEST 151030 1500 ~ 00501 303150000 © -~ T =~ :
GS segment ST segment
~ Sender Code Receiver Code Group Cortrol No ~ Version t Transaction 1D t
GS RA HIPAASUITE TEST 20151030 1500 303150000 X 005010X218 v ST 820
1

he "Create 820 Transaction Sets" window with the highlighted "Go!" button

4. You will see a confirmation dialog like this. Click "Yes."

You are about to create an 820 EDI file with 7 records. Are you sure?

The verification message before the EDI records are created

5. After you click "Yes," the process of assembling the claims to the 820 files starts.
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|
e ol

EDI creation started at 15:04:53 -
SQL Query: "SELECT * FROM EDI_Payments" E'
Mumber of found records: 7

Mumber of files: 1
Mumber of processed records: 7
Processing ended at 15:18:42

The Processing Results

6. The bottom pane informs you about the number of transactions created.

F ]

1 SELECT ~ - | HfectiveDate
2 FROM EDI_Payments 10/30/2015 [E~

| Select Trading Pariner |

™ | Fields with 1 will be populated by the process.

[ Exit ][ Got ][ Write to File ][ Send to Trading Partner || View EDI File Il Help ]

ISA segment )

T ~ Password 1D Type Sender ID ID Type Receiver ID Date Time - Interchange I Ack T/P -
00 ... 00 .. ZZ ~ HIPAASUITE ZZ ~ TEST 151030 1500 ~ 00501 303150000 0 ~ T =~ :
GS segment ST segment

 Sender Code Receiver Code Group Cortrol No ~ Version t Transaction D t
GS RA HIPAASUITE TEST 20151030 1500 303150000 ¥ 005010X218 ~ ST 820 0002
1 ISA™00* *00* ZZ*HIPAASUITE *ZZ* TEST *151030*1500"~00501*30315000070°T~"™ -

2 GES'RAHIPAASUITE*TEST*20151030%1500*303150000X*005010X218™
3 5T*82070001*005010X218™

4 BPRC*255*CACH"CTX"01"999959992 DA™ 123456781345678901™01199999999 " DA38765*19951103™
5 TRN*1*789051345678901™

6 REF*18*0011001™

7 DTM*009*19951101™

8 DTM*035*19951101™

9 NT*PE*BATA INSURANCE CO."FI*012222222™

10 NT*PR*ALFA MEDAL CO*1*123456783™

11 ENT*1*2J*34*030440095™

12 NMT*EY*T*"DOE*JOHN™"E|*777222™

13 RMR*IG*555666™30™

14 RMR™IG™55566735™

15 ENT*2*2J*34*029500563™

16 NMT*EY*1*FIRSTONE*EMILY™EI*777333™

17 RMR*IG*555777+45™

18 ENT*3"2J*34*029480664™

19 NMT*EY*1*MIDDLEONE™JULIE™EI*777444™
120 RMR*1G*54447740™
121 ENT*4*2J*347030498099™
122 NMT*EY*1T"NEWONE*KELLY™EI*777111™
123 RMR“‘IG:551165:45: -

124 DRAD*IC*EE B TRE**E

|2 EDI transactions are created.| -—

The bottom pane displaying the number of created EDI transactions

The EDI text is now displayed in the bottom part of the window.
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1 SELECT * Effective Date
2 FROM EDI_Payments 10/30/2015 [~

| Select Trading Partner |
™ | Fields with 1 will be populated by the process.

I Write to File Send to Trading Partner View EDI File

ISA segment
- ~ Password 1D Type Sender ID 1D Type Receiver ID Date Time - Interchange 1D Ack T/P -
00 00 ZZ ~ HIPAASUITE 77z ~ TEST 151030 1500 ~ 00501 303150000 O ~ 7T =~ :
GS segment ST segment
Sender Code Receiver Code Group Cortrol No ~ Version t Transaction D +
GS F{A HIPAASUITE TEST 20151030 1500 303150000 X 005010X218 - ST 82[] 0002
1|ISA™00* *00* 27 HIPAASUITE *ZZ* TEST *151030%1500*+00501*302150000%0*T=" -

2| GS*RAHIPAASUITE*TEST*20151030%1500*303150000°X005010X218™
3|5T*82070001*005010X218™

4| BPRC*255"C*ACH*CTX"01*999999992*DA™123456781345678501*01*199999995 DA38 76519951 103™
5| TRN™1*789051345678901™
6|REF*18*0011001™

7|DTM*009*19951101™

8|DTM*035%19951101™

S|NT*PE*BATA INSURANCE CO.*FI*012222222™
10|NT*PR*ALFA MEDAL CO*1*123456783™
T1|ENT=1*2J*34*030440099™
12|NMT*EY*1*DOE*JOHN™""EI*777222™

13| RMR*1G*555666™30™

14| RMR*IG*55566735™

15| ENT=2*2J*34*029500563™

16| NMT*EY*1*FIRSTONE*EMILY*=""EI*777333™
17|RMR*IG*55577745™
18|ENT*3"2J*34"029480664™
19|NMT*EY*1*MIDDLEONE*JULIE™EI*777444™
[20|RMR™IG*54447740™

[21) ENT*4*2J*34*030498099™
[2ZZ|NMT*EY*T*"NEWONE*KELLY=EI*777111™
123 RMR*IG*551165"*45"‘

2 EDItransactions are created. -_—

m

7. Now you can write down the EDI text that is still in memory and visible in the text box
to a file. Click on the "Write to File" button and you will have the choice to write in the
default location which is the trading partner's outbox, or specify any other location:

e Use default path and names

e Select path and names

1 SELECT ° Hffective Date
2 FROM EDI_Payments 1013042015 B~

[ selectTrading Partner |
™ | Fields with +will be populated by the process

[ Exit I Go! ] Write to File ][ Send to Trading Partner View EDI File

1SA nt

s:gme ~ Password 1D Type Sender ID RS Uitpapis e | Date Tme merchange D Ack TP
00 oo [T 7z ~ HIPAAg _ Selectpathend name 151030 1500 ™~ 00501 303150000 0 ~ T ~ :
GS segment ST segment

Sender Code Receiver Code Group Control No _ Vemsion t Transaction D +

GS RA HIPAASUITE TEST 20151030 1500 303150000 X 005010X218 ~+ ST 820 0002
TISAT0°  *00F  *ZZ° HIPAASUITE *ZZ* TEST  *151030~1500~*00501-30315000070~ T~ p
2 GS*RA*HIPAASUITE*TEST*20151030%1500%303150000°X*005010X218™ ﬂ

3 5T7820%0001*005010X218™
The "Write to File" button
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21

Save n: [ ) Sameles 2 [N e N5 B8 M

My Network [T fre<t

Saveastpe:  |EDI B20fies (820)

Hl
2

s |
_Coad |

The "Save As" dialog window

8. After successful writing, you get a message where the file was written to.

[ £

1 file is saved to C:\Documents and Settings\All Users\Appbcation Data\HIPAdsuite \HIPAA Premium Payment Master\Samples

with name:
test. 820

=

The confirmation message that the file was successfully written

Viewing the Saved Files

The button "View EDI File" is now enabled and you can bring up the EDI Editor to view it.
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, ,

1 SELECT ~ +| FHfectiveDate
2 FROM EDI_Payments 10/30/2015 [E~

| Select Trading Pariner |
™ | Fields with 1 will be populated by the process.

[ Exit I Go! I Write to File |[ Send to Trading Partner | View EDI File | Help ]
ISA segment
- ~ Password 1D Type Sender ID ID Type Receiver ID Date Time - Interchange I Ack T/P n
00 ... 00 .. ZZ ~ HIPAASUITE ZZ ~ TEST 151030 1500 ~ 00501 303150000 ©0 ~ T =~ :
GS segment ST segment
 Sender Code Receiver Code Group Cortrol No ~ Version t Transaction D t
GS RA HIPAASUITE TEST 20151030 1500 303150000 X 005010X218 ¥ ST 820 0002

2 GS*RAHIPAASUITE*TEST*20151030%1500*303150000°X005010X218™

3 5T*820*0001*005010X218™

1 ISA*00* *00* *ZZ HIPAASUITE  *ZZ* TEST *151030*1500**00501*303150000°0°T~"™ -
4 BPRC*255"C*ACH*CTX"01*9995999992*DA™123456781345678501*01*199999995"DA38 76519951 103™ H

The "View EDI File" button highlighted

The following preview window will open.
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Il
o] _soe |
1 ISA*D0* *00* *LEHIPAASUITE  “ZZ°TEST *131112*1153**00501*3161153270°P*:™ -

2 GS*RATHIPAASUITE*TEST=20131112%1153*316115327"X~005010X218~
3 ST"820"0001*005010€218™
4 BPR*C*19000*C*ACH*CTX*01*999958992* DA 1 23456 781030449999 01 199995999 DA™98 765199705 16™
5 THN*1"12345*1030449599™
& REF*18*12345~
7 DTM™009719970513™
8 DTM™035*19870514™
9 N1*PE*DEF HEALTH CARE INC *FI"0n2222222™
10 NT*PR*ABC PLASTICS*1"123456789™
11 ENT*1*2L*1*1234567589™
12 RMR™IK*970501001*PI*16500™
13 DTM*E82™RDs™
14 M=~
15 SLN*1"0"150"IE™
16 ADX"-141.48"A8~
17 RMR™K*970501001*PI*1500™
18 DTM*E82™RDs™
19 Tz~
20 SLN*2"0Q"30~E™
21 AMRIK*970501002°PI1*2500™
22 DTM™e82™RD&™
23 SE*21+0001™
24 ST"820*0002*005010X218™
25 BPR*U20000°C*ACH*CCP 01934 25781 3" DA 2345871 23155555501 *02567 783 3" DAS0EE 7766199 70620™
26 THN"3"12345"1231555585™
27 REFT18*673001™
28 REF*2F*0004369123™
29 DTM009*19970618™ |
30 DTM™D3519970619™
31 N1"PE*DEF HEALTHCARE CO*1*998216353™
32 N1"PR*ABC PLASTICS*1*000057811™
33 ENTT3*2J"34"179203456™
34 NMTEY*1*JOHNSON®JOE™™EI"934213™
35 RMR*CT*17920345630™
36 DTME82™RDg™
37 ADX-100752~
38 ENT=2*2)"34"163910163™
39 NMTEY*1*JONES*"MARY™ ™ EI*793016™
40 RMR*CT*163910163"10000*11000™
41 DTM*E82™RDg™
42 ADX-100"62~
43 ENT*1*2J*34*190206123™
44 NMTEY*1"SMITH*JOHN™""EI*123456™
45 RMR*CT*1902061237000™
45 DTME82™RD8™
47 ENT*3*2J"34*179203456™
48 NMT*EY*1*JOHNSON*JOE™  EI*934213™
49 RMR*CT*17920345630™
50 DTME82™RD3™
51 ADX-100"6R2~
52 ENT=2*2)734"163910163™
53 NMTEY=1"JONES"MARY™"EI*793016™
54 RMR*CT*163910163"1000011000™
55 DTM*E82™RD&™
a6 ADX-100"R2™
57 ENT*1*2J*34*190206123™ =

TN RIS BTN e S BETTL LS Bl IR 1SS SR e oy R e

EDI preview window

© <2006> ... Martin Scholl Consulting, Inc.



Using the Database 79

5.7 Troubleshooting Database Export

When you start exporting claims into the staging tables you might encounter errors at
first. This usually results from table definition issues. The HIPAA Premium Payment
Master displays a very detailed error message that tells you which claim failed, at what
field and if applicable, which line.

This information should help you to trouble shoot the problems. It sometimes takes
serious detective work to find and correct errors.

Below are some of the most common errors.

Item Cannot be Found
x

Error while updating Claim header table EDT_Claims’
Error 3265: Item cannot be found in the collection comresponding to the requested name or ordinal, in Sub “Write_SOL_Claim’

Claim Cownter: 1, with Provider's Claim Number: '1 3235
Fiehd: Claimbo
Valoe: 13235

This error happens when a column that was selected for export does not exist in the
Header table. In this particular case it is the field "ClaimNo." If you receive this error, go
back to your table admin tool and check in the field "ClaimNo."

Multi-step OleDB Operation Generated Errors
x|

Error while updating Clairm hesder table ‘EDT_Clains
Error -2147217857: Multiple-step OLE D8 operation generated emors, Chedk each OLE DB status value, i avalable. No work
was done. in Sub “Write_SOL_Claim'

Claim Counter: 1, with Provider's Claim Number: "1 3235

Field: BillProvSpecialty
Value: 000000002331

o-:|cm|

Typically, the message when the field definition in the database is different from the
data. Here we see that the error occurred with the billing provider's specialty. The field
definition in the table was set as varchar(10) and the value here:000000002331 has 12
digits, causing the error message.
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Field Doesn't Have a Default Value

Exporterror x|
Error while updating Claim header table EDI_Claims'
Error -2147217671: [My5QLYODEC 3.51 Driver Imysald-5.0. 16-ntJField 'Claimbio’ dossn't have a default value in Sub
"Wirite_SQL_Clain'

Claim Counter: 1, with Provider's Claim Number: '13235°

Fed: Updating Claimheader Table
ok | cocel |

The field "ClaimNo" is defined as "Not Null.” But somehow this data was not present and
HIPAA Premium Payment Master tried to update the table with a null d ai n\o.

Type Mismatch
x|

Error while updating Claim header table EDI_Claims’
Errof -2147352571: Type mismatch. in Sub Write_SOL_Claim'

Claimn Counter: 1, with Provider's Claim Number: '13235°

Field: BilProvlast
‘akse: LEE T

[ o ] concel |

This error occurs when the HIPAA Premium Payment Master tries to write a letter to a
field that is defined as "Integer” for example. The data type of the column does not
match the data type of the value.

Claim Detail Errors

Export Error ‘El

Error while updating claim detail table 'EDI_ClaimDetail
Error 3265: Item cannot b2 found in the collection corresponding bo the requested name or ordinal, in Sub “Wirite_S0L_Claim'

Claim Counter: 1, with Provider's Claim Number: *1 3235
Field: Lirehumnber

Value: 1

Line Mumber: 1

o] con |

The errors with the claim detail table are similar, only that the error message indicates
also at which line number it occurred.
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6 Automating
6.1 Using Command Line Arguments

The HIPAA Premium Payment Master can also accept command line arguments. This is a
very important feature if you want to put the HIPAA Premium Payment Master on a
scheduler and automate the processing of files or directories. Refer to Running the
Application via Scheduler.

The following is the list of the command line arguments; they must be separated by
commas.

1.The first command line argument is the filename or the directory path. If not
applicable, leave blank.

2. The second through fourth arguments following a filename or directory path are
reserved for processing options and are triggered by a "Y" as followss:

e 2nd argument — Export to database.

C:~Program Files*HIPAAsuite~HIPAA Premium Payment Master>*HIPAAPremiumPaymentMast

er.exe D:“EDI-B2H_1.edi.¥
Using the Export to Database option as a Command Line Argument

¢ 3rd argument — TIFF/PDF File. The payment order/remittance advice will be saved
as a TIFF image file.

See Creating Image Files from EDI for details on how to set up the Image printing
capabilities.

Be sure that you have tested the Image printing, before trying the command line
mode.

C:“Program Files“HIPAAsuite“HIPAA Premium Payment Master*HIPAAPremiumPavmentMast

er.exe DNEDINB2B_1 _.edi..¥Y
Using the TIFF/PDF Image option as a Command Line Argument

e 4th argument — Print. If the fourth argument following a filename or directory
path is filled with a "Y", the 820 file will be printed without ever being displayed
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6.2

C:“Program Files“~HIPAAsuwite~HIPAA Premium Payment Master>HIPAAPremiumPaymentMaszt

er.exe D:SEDI~B268_1_edi,..¥

Using the Print option as a Command Line Argument
Again, be sure that you have tested the Image printing before trying the command

line mode.

Using Several Arguments

You can have a combination of the above arguments. For example,

C:sProgram Files“HIPAAzuite~HIPAA Premium Payment MHaster*HIPAAPremiumPaymentMast

er.exe D-~EDI-~B20_1.edi.¥..¥

will both export the "820_1.edi" file to the Database and print the file.

Processing ended at 10/30/2015 2:18:52 PM

Processing of ‘DAEDNEZ0_1.edi started at 10/307/2015 2:20:37 PM
Processing of the file 820_1.edi began at 10/230/2015 2:20:37 PM

Premium Payments will be printed

Premium Paymentz will be exported

1 Records have been processed

1 Premium Payment Records have been printed

1 Premium Payment Records have been exported to Live database

Processing of the file 8220_1.edi ended at 10/30/2015 2:20:33 PM

Processing ended at 10/30/2015 2:20:33 PM
1

Excerpt from HIPAA Premium Payment Master log after command line processing.

Processing with the EDI Exchange Module

Processing EDI Files with the EDI Exchange Module Enabled

The only argument you need in this case is "Auto”. The directory to look for new files and
the processing options are defined in the setup screens for EDI Exchange. No further
arguments are needed.

To setup autoprocess options, go to EDI Exchange -> Autoprocess Setup
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Log | EDI Exchange | Help

=) "' ,ﬁ Check EDI File

Trading Partners
& Inbox Manager

FTP Client

SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Create 999 Files Tables
Autoprocess Setup |I

Autormatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License

EDI Exchange License Information

Autoprocess Setup option in EDI Exchange menu

Any options selected for autoprocessing will carry over to the command line.

,

Get Rles from Trading Partners
Check FTP servers for new files and place them into Inbox

Default Automatic Processing Options

Export in Database Create Autoresponse
Print
Save to: Image Excel ASCI

EDI Exchange Automatic Processing options

83

© <2006> ... Martin Scholl Consulting, Inc.




84

The HIPAA Premium Payment Master

6.3

Working with the Database

To generate an 820 payment order/remittance advice file using the Database, the
following command line arguments are needed in order:

1. Query - The full query to generate the desired transactions. Querying multiple rows will
result in an 820 with multiple transactions.

2."EDI" - To flag the query for EDI file creation.

3. Resulting filename - A filename for the resulting file. A fully qualified path may be
used. A relative address (ex: "\820forTradingPartner\820.edi") will result in the file
being written to the EDI Root directory.

4. Trading Partner - The trading partner to be used to build the ISA and GS segments. If
this argument is left blank, the last Trading Partner used to build an EDI file in the
Create 820 Transaction Sets window will be used.

Example of creating an EDI file from a database query:

C:~Program Filez~HIPAAsuite~HIPAA Fremium Payment Maszter>*HIPAAPremiumPaymentMas

er.exe "SELECT TOP 2 = FROM EDI_Payments", EDI . D:~EDI~TESTE28_B6.edi.LOCAL
EDI file creation command specifying records with a query.

The above example has:
e A query in the first argument.

e The second argument is 'EDI', meaning that an EDI file is to be created using the
results from a SQL query.

e Argument 3 is the filename for the resulting file. Since p:\ EDI\ TEST820_06. edi iS a
fully qualified path, the file is not written to the EDI Root directory and instead uses
the specified path.

e The fourth argument specifies the ISA identifier of the destination trading partner.
This works only with the EDI Exchange module enabled.

and will result in an EDI file named "TEST820_06.edi" in "D:\EDI\" containing the results of
database query "SELECT TOP 2 * FROM EDI_Payments". The following is the log entry
created by this command:

© <2006> ... Martin Scholl Consulting, Inc.



Automating 85

6.4

EDM creation started at 14:458:39
SQL Query: "SELECT TOP 2 * FROM EDI_Payments”
Mumber of found records: 2

MNumber of files: 1
MNumber of processed records: 2
Processing ended at 14:45:39

File iz created: DAEDRTESTE20_08.820

Excerpt of HIPAA Premium Payment Master log.

Changing the Default Company

The default company is the identity you assume as the sender when creating EDI files.
This affects the ISA, GS, and NM1 sender segments. A single entity may have a need to
act as multiple sender identities and so has a need to change the information in the EDI
envelopes.

The default company can be changed using command line arguments, affecting the ISA
and GS sender ID segments.

ISA Segment Sender Identifier HIFAASUITEN

Qualifier Z7 - Mutually Defined -
Application Sender's Code GS_2 HIPAASUITEN *
Tax ID 9876543210 *

Sende?IID sle'_éments inHComp;aTwy Setup

To change the default company, a single argument is needed. "Setcompany” followed by
the company ID of the company you wish to set.

"set conpany <I| D>"

The Company’s ID in this case is not its EDI identifier, but the value of the ID row in the
COMPANY_SETUP table. It can also be found in the Company Setup window:

Current Company: S0 lEa 2= v | 4y Default company
1 - TESTRESPOMNDER

2 - HIPAASUITE

3 - HIPAASUITEZ
- Add company -

Company selection in Company Setup

Example

© <2006> ... Martin Scholl Consulting, Inc.



86

The HIPAA Premium Payment Master

6.5

The command argument set conpany 3

C:“Program Files“HIPAAszsuite~HIPAA Premium Payment Master>*HIPAAPremiumPaymentMast

er.exe setcompany 3

will set the default company to ID = 3, which is HIPAASUITE2 in the example picture
above. The log entry for this command will be

'Set default company with ID 3
Company # 3 iz 2et as a default company

Excerpt from log. Default company changed.

Running the Application via Scheduler

The HIPAA Premium Payment Master can be automated through a scheduler. A scheduler
is software that can be programmed to execute a certain task at a certain time
repeatedly. Windows has such a scheduler built in.

The Windows scheduler can be used to let the HIPAA Premium Payment Master execute in
regular intervals without user intervention. Usually one would let the HIPAA Premium
Payment Master scan a directory and then print, create image files or export the data
and remove the files to prevent duplicate processing.

Note: Please consult Windows help files for further information on setting up the scheduler.

1. If the task scheduler is installed on your system, you will find it in the "Control Panel'.
To open Scheduled Tasks, click Start » Control Panel v Scheduled Tasks.

Note: In different Windows versions, the way to access the Task Scheduler can differ. Consult your
Windows version documentation.
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8 Scheduled Tasks =101 =]
File Edt View Favorites Tools Advanced Help | &
Qesck - ) - ._‘ﬁ‘|)__3mm | Felders ‘-
Address |4 schedued Tasks B> e
Name = | schedule | Mot Run Time | Last Run Time | Status
|.2] Add Scheduled Task
Other Places & @phGooglelpdateTaslserS-1-5-... At 12:07 PMevery ... 12:07:00FM ... Never Couid not skark

@ Control Panel
(L) My Documents
{25 Shared Documents
W My Network Places

Details ¥

4| |

a =

[z objects

The Windows Task Scheduler

2. Click on "Add Scheduled Task" and the "Scheduled Task Wizard" will guide you through
the setup process.

3. In the first window, read the welcome message and click "Next."

Scheduled Task Wizard x|

This wizand helps you schedule a task for Windows
to perfom,

You select the program you want Windows to run,
and then schedule & for a conveniant tims,

Click Neot to continue.

The "Scheduled Task Wizard" window

4. Browse to the Hi PAAPr eni unPaynent Mast er . exe executable file.
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Scheduled Task Wizard ‘El

Click, the progeam wou want Windows bo mun.
To see more programs, chck Browse.

| Wersion =]
2] 7 Zip Fil Manager 457 wed
& sccessibilly Wizard 5.1.2600.551..
@) ACDSes Pro 25
d bddiess Book 6.00.2300.55.,
& 2.dobe Bridge C53 20
) &dobe Device Cenial C52 100
L R R, g - | =N ED ,ll

(sowe.|)

[ <Back | neis | Coneel |

The "Scheduled Task Wizard" window

By default, the application is located in c:\ Program Fi | es\ HI PAAsui t e\ Hl PAA Preni um
Paynment Mast er\ Hl PAAPr em unPaynment Mast er . exe

é{_}c | |~ Program Fles = HIPAAsute = HIPAA Premium Payment Master = » 23 [ search HiPas Premium Payme. . (2]
Organize ~  News folder =+ [ @
/7 Favorites ~] __Name - Date modified Type Siza -
B Desktop || CustomactionLibrary. InstalState LI/11f2013 1156 AM  INSTALLSTATE File 3KB
8 Dowrloads “ Dynamichrray.dl 11/4f2013 12:31 PM Application extersion 14 KB
= Recent Places
“#, EDI_Exchange.dl 11/4/2013 12:31 F4 Application extersion 403 KB
- Libraries & EDIdEv.FrameworkEDT. NET4 x64.dl 1142015 12:31 P Application extension 5,514 K6
{| Documents B £ idey_FREDI_Runtime.exe 11/4{2013 12:31 B Application 24,211 KB
& Music %, Edivare.dl 11/4/2013 12:31 P Application extension 27 KB
i Pictures ) FindReplace.dl 11/4/2013 12:31 FM Application extenrsion 24 KB
B videos %, HipaaCusbomControls.dl - 11/4/2013 1231 PM Application extension 24 KB
W Computer ( & HIPAAPremiumPaymenthaster, s 11/4f2013 12:31 PM Application
£2. Local Disk (C:) % HIPAAPremiumPaymentMaster exe.config 11/4/2013 1231 P4 %ML Configuration File KB
5 DATAPARTI (D2 % HIP&AUktes di 11/4/2013 12:31 PM Application extension 356 K8
. $tPendingFies %, ICsharpCode. AvalonEdit di 11/42013 12:31 B Application extersion 454 KB
. $RECYCLE.BIN :I i Trbmran ferePDiE i Al NAAAIPNIR 1770 B Annkieabinm s yvkensian 1T KR j

File narme: Ikﬂpmp‘remium Payrmenthdaster.exe EI l-ﬂ" files (**) 3

( I Open I ) Cancel |

Selecting a program to schedule
Click "Next."
5. Type a name for this task. Choose a time interval:

e Daily
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e Weekly
e Monthly
¢ One time only
e When my computer starts
e When | log on
Click "Next."

scheduled Task Wizard x|

Type 2 name forthis task, The task name can be
the same name as the program name.

] HIPAAPremiumPaymentiaster
Pesform this task:
-

0 [Weskiy
=

- time only
" [When my computer sads
* [When llog on

= @Y e

The "Scheduled Task Wizard" window

6. Enter the name and password of a user. The task will run as if it were started by that
user. Click "Next."”
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Scheduled Task Wizard x|

Enter the name and password of 3 user. The task wil
run as f it wars staded by that usar.

—

-
Enter the user name: ILEEI‘
Enter the password: Inuouv

Confirm password: [sesnssne

If a password is not anterad, scheduled tasks mght
not run.

The "Scheduled Task Wizard" window

7. In the last screen, make sure you have specified all data correctly. Click "Finish" to
save your task.

Scheduled Task Wizard x|

You have successfully scheduled the following task:
23 HIPAAPremiumPaymentMaster

Windows will perform this task:
Flun at user logon

r Eﬂip:ﬁhgdvmcedpmpmﬁfnrﬂistad{vhmlchdc

Click Finish to add this task to your Windows scheduls.

The "Scheduled Task Wizard" window

8. The scheduled task has been added to the system. Now lets edit the new task and add
the desired command line arguments with the appropriate options. Double-click the newly
created task in the "Scheduled Tasks" window.
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8 Scheduled Tasks =10 x|
File Edit Yew Favosites Tools Advanced Help "
g Bk - g - ? y Search Folders v
Address [ ] Scheduled Tasks Rl
~| Name = | Schedule | Mecet Run Time | Last fun Time | Status
Folder Tasks & 1_j.0.dd Scheduled Task
A yGoogleUpdataTaskllsers-1-5-... At 12:07 PM every ...  12:07:00FM ... MNever Coudd niok skark

'ﬂ: Renane this tem

: -4 HIPAAPremiumPaymentMaster TR )] A user logon Mewer
Ay Move this tem

[ Copy this item
B¢ Delete this item

The Windows Task Scheduler

9. Enter parameters to the "Run” field after the application path and click "OK."

Tip: Logs may be helpful when running the program automatically through the scheduler. See
Accessing Logs.

7 Using EDI Exchange Features

7.1  Getting Started
7.1.1 About EDI Exchange

EDI Exchange is a module available in most HIPAAsuite EDI applications. It is an option
that you can purchase for an additional cost. Some of our products, such as HIPAA Claim
Master, process EDI files but do not receive or send EDI files to and from your trading
partners. EDI Exchange is created to do that. EDI Exchange is designed for those
organizations that have a large volume of EDI files, need more order and automation and
adhere to tougher compliance rules. The EDI Exchange is an EDI pre-processor that
handles FTP transport, encryption, HIPAA compliance check, trading partner
management, etc. Outgoing EDI files can be checked for compliance; individual records
that do not pass the check can be withheld.

HIPAAsuite products with EDI Exchange module have a main menu item called "EDI
Exchange” with sub-menus to call the module’s functions.
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|

File  View Database CodeSets Image Setup Log IEDIExchangEIHEIp

. e T 7= Check EDI File
— .
— 2
g

Trading Partners

mm Mode Inbox Manager

SR FTP Client

i SEF Files

© Spreadsheet Fie EDI Exchange Setup

(©) ASCII File Encryption Setup

() Image File Create EDI Exchange Tables
Create 999 Files Tables

[[] Data Export Autoprocess Setup

Counter . Automatic Scheduler

Files |:| N EDI Receive Log
Records [ | . EDI Send Log

Request EDI Exchange License
Run " EDI Exchange License Information

The "EDI é;(chaﬁée" menu in HIPAA Enrollment Master
EDI Exchange performs the following functions:

¢ Trading Partners Management — The following Trading Partner's parameters can
be stored and transparently managed with the help of EDI Exchange: name,
address, EDI identifiers, delivery methods, encryption parameters, FTP servers,
CORE-Compliant server addresses and credentials, communication numbers and
folders to keep files separated, special requirements specific to this trading
partner. Read more in Setting up Trading Partners.

e File Transport — EDI Exchange has a built-in FTP client that can securely connect to
your trading partner's FTP servers. If you employ your own FTP server, you can
utilize the folder structure that EDI Exchange uses to manage incoming files, users,
home directories and permissions so that your Trading Partners can drop off and
pick up EDI files. Supported are:

e Simple FTP

e FTP Secure
e Implicit FTPS
e Explicit FTPS
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e Secure Shell FTP or sFTP

Read more in Using FTP Client.

e Encryption — Many healthcare-related companies use encryption to cloak the
content of their EDI files. The prevalent method of encryption is PKI (Private Key
Infrastructure) that uses the product of two incredibly large prime numbers as
cipher. EDI Exchange supports PGP (Pretty Good Privacy), the leader in PKI products
as well as the open source GPG project with its Windows sub project PGP4Win. Both
are implementations of the same encryption mechanism. Read more in Using
Encryption.

¢ File Management — EDI Exchange uses a clear directory structure to store EDI files.
The structure is based on root directories for incoming files, outgoing files,
processed files and suspended files. Below these root directories, there are
subdirectories for each trading partner and then each transaction set. Read more
in Defining Root Directory and Initializing EDI Exchange.

e EDI Compliance Check — EDI standards are strict and precise; adherence to the
standards is very important so that any organization can work with them regardless
of their backend system software. EDI Exchange has a built-in compliance engine
that checks incoming files for compliance. The engine also generates a report listing
each problem with the exact location. Outgoing EDI files can also be checked and
you have an option to withhold individual records that violate the rules. Read more
in Checking EDI Files.

e EDI Control for Transactions — The EDI protocols have a few supporting transaction
sets that are useful to the smooth functioning of EDI exchanges. They provide the
sender with an instant feedback on receipt. The following transaction sets are
available:

e TA1 Acknowledgment
® 997/999 Functional Acknowledgment
e 277U/277CA Unsolicited Claim Status Response (in case of Claims)

¢ Logging — EDI Exchange has several logs that are instrumental to keep processing in
order and allows to forensically investigate mishaps. There are three logs in EDI
Exchange:

¢ Incoming file log — See Accessing EDI Receive Log.

e Outgoing file log — See Accessing EDI Send Log.

¢ Daily transaction log
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7.1.2

Requesting EDI Exchange License

If your trial has expired, you can request an extension to the trial.

If you purchased the product and need a final license key, you should request an EDI

Exchange license.

Follow the instructions below to request a trial or final license key.

1. Select "Request EDI Exchange license” under the "EDI Exchange" menu item.

File  View Database Codebets

law | > | [

Output Mode

@ Screen

() Printer

(7} Spreadsheet Filz
(71 ASCII File

7 Image File

[7] Data Export
Counter

oo [

Run P‘

Run with

A menu item to request a license key

Image

L

|

Setup

Check EDI File

Trading Partners
Inbox Manager

FTP Client
SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Create 999 Files Tables
Autoprocess Setup

Autornatic Scheduler

EDI Receive Log
EDI 5end Leg

Request EDI Exchange License

EDI Exchange License Information

2. Once you have clicked this menu item, your default email application appears. In our
case, it is Microsoft Outlook. All information necessary to produce the key is

automatically filled out.
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From = Martin. Scholl@HIPAASUte.com

To.. nfe BHIPAASEE com
Ci...

Send

Bec...

Subject: [HIFAA Premium Payment Master |[TBOCFSEBF]: Request for Trial License Ex
Request for Trial License Extension

Product: HIPAA Premium Payment Master
Volume ID: 7T8DCFBBF

Already licensed features:
Image Creation,

File Creation,

Work with Database,
Claim Entry/Edit

Required new features: No new features selected to request for license

Current Key:
Trial Key: E1IRNO-QOPO0-GHFJF-KBMSP-5A48Y-EGI6I-6D3WIKS

Email message created by EDI Exchange

3. You can add a trial extension or a final key after purchasing or relocating the
software.

Once you receive the response with the key for EDI Exchange, you can bring the
"Registration Form" screen up again and click on "Register”. Enter the key to unlock EDI
Exchange. In the Result area, you will see that EDI Exchange has been registered.
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7.1.3

License Registration Form
EDI Exchange

License Key

Reqister ][ Close

Result

Thank you for evaluating ED| Exchange!
EDN BExchange is fully functional with certain trial limitations.
This evaluation version expires in 14 days

Entering the license key

Registering EDI Exchange

EDI Exchange is licensed separately from the host application, HIPAA Claim Master, for
example. The reason is that EDI Exchange will work on all HIPAAsuite Products that are
installed on your particular computer. For example, if you have HIPAA Claim Master and
HIPAA Enrollment Master licensed, only one license of EDI Exchange is needed and the
module will work across two products.

When you first install a HIPAAsuite product of your choice, a 15-day EDI Exchange trial is
included. Once the trial expires, EDI Exchange loses its functionality. The menu items
under "EDI Exchange” become disabled except the last ones that allow you to license and
enable the product.
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A HIPAA Claim Master - 32bi

File

Forms  View  Search  Claim Entry/Edit

’ |:||> |

Data Base  Code Sets

E RO O

Logs

97

EDI Exchange | Help

Image  Setup

Check EDI File

) Image Fle

Data Import
Claim Type

() Professional
) Institutional
() Dental

) Reporting
Counter

Total

Output Mode
) Printer

@ Screen

Amourt

The "EDI Exchange” menu with menu items disabled

You can register the product by clicking on the "EDI Exchange License Information” option

under the "EDI Exchange"” menu.

EDI Exchange | Help

Check EDI File

Trading Partners
Inbox Manager
FTP Client

SEF Files

&

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Create 999 Files Tables
Autoprocess Setup

Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License

: EDI Exchange License Information

Trading Partners
Inbox Manager
FTP Client

SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Create 999 Files Tables

Autoprocess Setup
Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License

EDI Exchange License Information
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"EDI Exchange License Information” option under the "EDI Exchange”

Then the license screen appears. In the lower left corner you can find the unique
registration number needed to create either trial extensions or final licensing.

R )

EDI Exchange

1.0
Day(s) remaining for trial 8

This software is for evaluation purposes only and has limited
functionality

You will have to purchase this software if you want to continue using it
after a free evaluation has expired.

Registration Mumber:
3E76196D [

Ty || Orer || Regater |

The license information screen

Once you click on "Register," you can enter the license key that you have previously

received via email from us (see Requesting EDI Exchange License.) Click on "Register" and
you will see the registration message in the "Result” area.

T . ==

License Registration Form

EDI Exchange

License Key

[ Regigter ][ Close

Result

Thank you for evaluating EDI Exchange!
ED| BExchange is fully functional with certain trial limitations.
This evaluation version expires in 14 days
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Extending the trial by entering a license key
Close the "Registration Form" and continue using the EDI Exchange.

7.2 Configuring EDI Exchange (Obligatory Settings)

7.2.1 1 Setting up Database Connection

EDI Exchange work is based on the database connection that you define under Database »
Connection and Data Fields in the main menu of the HIPAA host application. Make sure
the connection has already been set up and tested before proceeding with EDI Exchange.

Then proceed to the next step: Creating Database Tables.

7.2.2 2 Creating Database Tables

Once you have configured the database connection (Setting up Database Connection),
follow the instructions below.

1. Select EDI Exchange » Create EDI Exchange Tables in the main menu.

Check EDT File

Trading Partners

Inbox Manager

FTP Client
SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Create 999 Files Tables

Autoprocess Setup

Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License

EDI Exchange License Information

-

The menu item to create the necessary tables.
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2. The "Create Tables for EDI_Exchange" screen will appear. Table creation and/or
modification for your database is handled here.

F R

Database
@ Microsoft SQL Server ) MySQL/Generic

Trading Partner | TRANS_LOG | TRANS_LOG_ERRORS | SEND_LOG | cOMPANY_SETUP|

TradingPartner Table script:
1 CREATE TABLE [dbo] [TradingPartner]( -

2 [TradingPartnerlD] [varchar](15) NOT NULL,
3 [TradingPartnerlD_QUAL] [char](2) NULL,
- [ETINMo] [varchar]{15) MULL,
5 [NAME] [warchar](40) NULL.
6 [Contact] [varchar](100) NULL.
7 [Phene] [varchar](15) NULL.
8 [Extension] [varchar](10) NULL,
9 [Email] [varchar](75) NULL.
10 [Fax] [wvarchar](15) NULL.
1 [LocalFtpUser] [varchar](20) MULL.,
12 [LocalFtpPassword] [varchar](20) NULL,

13 [Address1] [varchar](100) NULL,

- [Address2] [varchar](100) NULL,
[City] [warchar](30) NULL.,

16 [State] [char](2) MULL,

7 [£ip] [wvarchar](10) NULL,
[FtpAddress] [varchar](50) NULL,
[PutDirectory] [varchar]|(50} MULL.
[GetDirectory] [varchar](50) MULL,

21 [FtpArchive] [varchar](20) NULL,
[FtpUserMame] [varchar](40) NULL.
[FtpPassword] [varchar](40) NULL.
[FTPPort] [warchar]{12) NULL,

25 [Outbax] [varchar]{50) MULL, N

l Compare Script with existing Table ] Save l [ Execute Script l

The screen to create the tables
3. Select the database type you use for your host HIPAA application.
e Database
e Microsoft SQL Server (SQL Server 2008 and above)
e MySQL

Note: In case your database is not listed, modify the scripts or ask your database administrator to
make the necessary modifications.

4. The following tables are part of EDI Exchange:

e TradingPartner — SQL statements to create the "TradingPartner” table in your
database. This table contains information about trading partners.

e Trans_Log — SQL statements to create the "TRANS_LOG" table in your database.
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This table contains incoming file information, keeps track of all EDI files that you
receive and the compliance check report.

e Trans_Log_Errors — SQL statements to create the "TRANS_LOG_ERRORS" table in
your database. This table collects the results of the compliance check and keeps
track of all sent files.

e Send_Log — SQL statements to create the "SEND_LOG" table in your database.
The table contains information about EDI files created and sent to trading
partners.

e Company_Setup — SQL statements to create the "COMPANY_SETUP" table in your
database. This table collects information about you, the sender of EDI
information.

5. You can modify the scripts so that they run on your specific database. Once you have
you modified the script, click "Save."

Tip: Every database system has their own little syntax idiosyncrasies and the scripts might require
tweaking. You can edit the table scripts in this screen and save your modified scripts. One example
are 'date’ and 'time’ or ‘'money' data types that do not exist in SQL Server 2005. You can just rename
those types to 'datetime’ and save you script and it will run fine.

F B

Database
@ Microsoft SQL Server ) MySQL/Generic

Trading Partner | TRANS_LOG | TRANS_LOG_ERRORS | SEND_LOG | COMPANY_SETUP|

TransLog Table script:

T CREATE TABLE [dbo] [TRANS_LOG( R
[1D] [varchar](200) NOT NULL, B
[PayloadID] [varchar](200) NULL,
[TRADING_PARTNER] [varchar]{15) NULL
[TRANSACTION_TYPE] [char](3) NULL.
[ORIG_TRANSACTION_TYPE] [char](3) NULL,
[PROCESS_DATE] [date] NULL,
[PROCESS_TIME] [time](0) NULL.
[OPERATOR] [varchar](20) NULL.

10 [RECORD_IDS] [varchar](2000) NULL.

11 [RECORD_COUNT] |bigint] I\{ULL.

WO =N N £ LIk

m

- [CHECK_MESSAGES] [bigint] NULL,

15 [RespanseFile] [varchar] (300) NULL,

16 [AcknowledgementFile] [varchar] (300) NULL,

7 [ExitCode] [smallini] NULL.

18 CONSTRAINT [PK_TRANS_LOG] PRIMARY KEY CLUSTERED

20 [IDJASC

]
22 ) ON [PRIMARY]
23 =

-

[ Compare Script with existing Table ” Drop TRANS LOG schema [ Save ” Execute Script ]
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The "Save" button

6. For each script on every tab, click "Execute Script” to create the corresponding table

in the database.

F R
Create Tables for EDL_Exchange ol o

Database

@ Microsoft SQAL Server ) MySQL/Generic

 Trading Partner || TRANS_LOG | TRANS_LOG_ERRORS | SEND_LOG | COMPANY_SETUP |

TradingPartner Table script:

1 CREATE TABLE [dbo] [TradingPartner](
[TradingPartnerlD] [varchar](15) NOT NULL.
[TradingPartnerlD_QUAL] [char](2) NULL,
[ETINNo] [varchar](15) MULL.

[NAME] [warchar]40) NULL.

[Contact] [varchar]{100) NULL,

[Phone] [warchar](15) MULL,

[Extension] [varchar](10) NULL,

[Email] [varchar](75) NULL.

[Fax] [varchar]{15) MULL.
[LocalFtpUser] [varchar](20) MULL.,
[LocalFtpPassword] [varchar](20) NULL.
[Address1] [varchar](100) NULL,
[Address2] [varchar](100) NULL,

[City] [warchar](30) NULL,

[State] [char](2) NULL,

[Zip] [varchar](10) NULL,

[FtpAddress] [varchar](50) NULL,
[PutDirectory] [varchar]|({50} MULL.
[GetDirectory] [varchar](50) MULL.
[FtpArchive] [varchar](20) NULL,
[FtpUserMame] [varchar](40) NULL.
[FtpPassword] [varchar](40) MULL.
[FTPPort] [warchar](12) NULL.

[OQutbox] [varcharl(50) NULL.

l Compare Script with existing Table ]

S ————
L0 00 ] O LN e Ll P — 00 00 =] 0N N e LIRS

P B T 3 B Tl
N e Ll b =22

-

Save l[ Execute Script l

The "Execute Script” button

Notice: Creating tables means clicking the "Execute Script” button in all five tabs of the "Create Tables

for EDI_Exchange" window. Then close this window.

7.0nce the table has been created successfully, you will see the following notification:

SuCcess

==

Table 'TradingPartner' successfully created

The Create Table script success message
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Warning: Double-execution of a script wipes out the previous table you have created. A prompt will
warn you before deleting an existing table. To Add/Remove fields use the "Compare Script..."
button. Remove the script files once you have created the tables so nobody can destroy the tables
by accident.

( Caution ‘ l_‘*_] ]

Iel This action will wipe cut all your data in TradingPartner table. Proceed?

ves || Mo

e R 1 T

The double-execution warning message.

Make sure there are no error messages and the table creation has been completed
successfully.

Compare Script with existing Table

HIPAAsuite products go through continual development and improvements. Often these
changes lead to new fields in the database. While it is easy to drop a table and
regenerate it with the new fields, you will loose all the data in the table. To avoid this
trouble there is the button "Compare Script with existing Table". | you click this, the
table structure in your database will be compared with the script. There are two possible
outcomes. Your table is up to date

- =)

You hawve all the fields in your table,
There is nothing to do

o]
. — —
Table is up to date

or if your table is missing recently added fields, you will see a window pop up that shows
an 'Alter Table' script with which you can add those fields to the table without interfering
with existing data.
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7.2.3

n'J Changes to your tab_ll LI_Ig

1 Alter Table TradingPartner

Add
[SourceEntitylD] [char](2) NULL.
[SourcelDQualifier] [char](2) NULL,
[SourceMame] [varchar]{50) NULL.
[SourcelD] [varchar](50) MULL

N LT ek L P

-

Execute Script ]

The 'Alter Table' script that shows as a result of missing fields

You can now click the "Execute Script” button and the field will be added and a message
will confirm your changes

. =)

Table successfully altered

| |

Alter Table statement successfully executed.

Once you have created the tables, you can start setting up the other application options.
See the next step: Defining Auto-Processing Options.

2b Creating 999 File Tables

Once you have configured the database connection (Setting up Database Connection),
follow the instructions below.

1. Select EDI Exchange » Create 999 Files Tables in the main menu.
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EDI Exchange | Help

Check EDI File

— Trading Partners -
é Inbox Manager
FTP Client
SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Create 999 Files Tables

Autoprocess Setup

Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License

EDI Exchange License Information
g [ - — L | Smm—————

The menu item to create the necessary tables

2. The "Create Tables for 999 Files" screen will appear. Table creation and/or
modification for your database is handled here.

105
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F ™

Database
@ Microsoft SQL Server ) Oracle O MySQL/Generic

ImplementationAck |Transac1.ionF{espcmse | SegmentErrors | Elemenﬂ'\lutes|

ImplementationAck Table script:

1 CREATE TABLE ImplementationAck( -
[ID]int IDENTITY NOT NULL.
[FileName] varchar{100) NULL.
[SenderlD] varchar(15) MULL,
[SendTime] datetime NULL.
[GroupControlNo] varchar(9) NULL,
[TransactionControlNo] varchar(9) NULL,
[FuncitionallD] char(2) NULL,
[OnginalGroupControlMa] varchar(9) NULL,
10 [Version] varchar{12) NULL.
1 [AckCode] char(1) NULL,

[IncludedTS] int NULL.
13 [ReceivedTS] int NULL,

[AcceptedTS] int MULL.

LD 00 s O 0N fe LIPS

[ErrorCode1] char{3) MULL.

[ErrorCode?] char({3) NULL,
7 [ErrorCode3] char{3) MULL.

[ErrorCode4] char{3) NULL.
19 [ErrorCode5] char{3) NULL,
20 PRIMARY KEY ([1D])

’ Compare Script with existing Table Save l [ Execute Script l

The screen to create the tables
3.Select the database type you use for your host HIPAA application.
e Database
e Microsoft SQL Server (SQL Server 2008 and above)
e Oracle
e MySQL

Note: In case your database is not listed, modify the scripts or ask your database administrator to
make the necessary modifications.

1. The following tables are part of EDI Exchange:

¢ ImplementationAck — SQL statements to create the "ImplementationAck” table in
your database. This table contains information about Acknowledgments.

¢ TransactionResponse — SQL statements to create the "TransactionResponse” table
in your database. This table contains individual transactions contained in 999 files.
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